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1 Instalación y licencia de Zeno Field y Zeno Connect
1.1 Instalación en CS10/CS15
1.1.1 Zeno Field

Instalación Zeno 
Field en 
CS10/CS15

1.1.2 Zeno Connect

Instalar Zeno 
Connect en 
CS10/CS15

Paso Descripción
1. Descargue el instalador Zeno Field más reciente en myWorld@Leica Geosys-

tems (https://myworld.leica-geosystems.com). Lo encontrará en esta 
ruta: myDownloadsSoftware > Zeno Field

2. Copie el archivo Leica ZenoField.ARM.CAB a CS10/CS15 en la carpeta de 
archivos de programa y haga doble clic en el archivo.

3. Así se instalará Leica ZenoField.ARM.CAB.
4. Para empezar Zeno Field, haga doble clic en el icono de acceso directo del 

escritorio.

Paso Descripción
1. Descargar el instalador más reciente Zeno Connect en CS10/CS15 de 

myWorld@Leica Geosystems (https://myworld.leica-geosystems.com). 
Lo puede encontrar en esta ruta: myDownloadsSoftware > Zeno 
Connect

2. Copiar el Leica ZenoConnect.ARM.CAB en el CS10/CS15 en la carpeta 
Program Files y pulsar dos veces sobre el archivo.

3. El Leica ZenoConnect.ARM.CAB se instalará.
4. Para iniciar Zeno Connect, pulsar dos veces sobre el icono de acceso directo 

en el escritorio.
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1.1.3 Activación de Licencia para CS10/CS15

Licencias para el 
Zeno Field/
Zeno Connect

Para usar el Zeno Field y el Zeno Connect, se requiere una licencia válida.
En la Gestión de licencias es posible registrar licencias para:

• Zeno Field: licencia para Zeno Field, contraseña para Zeno GIS y claves CCP.
• Zeno Connect: licencia para Zeno Connect, contraseña para Zeno GIS y claves 

CCP.
• GS05/GS06: Agregar licencias GPS y GLONASS al GS05/GS06
• GG02 plus: Opción GLONASS

Todos los equipos Zeno se entregan con licencias previamente instaladas. Además, las 
claves de las licencias se entregan también en formato impreso. En algunos casos es 
necesario registrar nuevas claves de licencia, por ejemplo, si la licencia para CCP ha 
vencido.

Cómo registrar una 
licencia de 
Zeno Field

Cómo registrar una 
licencia de 
Zeno Connect

Licencias para el cap 
Zeno Field 
GNSS GS05/GS06

Hay dos tipos de licencias para el cap GNSS, las cuales pueden ser solicitadas por el 
usuario cuando compra el equipo:

a) GPS solo
b) GPSyGLONASS

Paso Descripción
1. Inicie el gestor de licencias en su CS10/CS15 accediendo a 

Start\Programs\Zeno Tools\Licence Manager.
2. Introduzca las claves de licencia en base a los campos en la Zeno Field 

pestaña.
O pulse Browse y explore el archivo de licencia. Así se rellenarán todas las 
claves incluidas automáticamente. los cuales son:

• Zeno GIS Clave: Permite CS10/CS15 para Zeno Field
• Zeno Field Clave: Licencia para Zeno Field
• Clave CCP: Clave de mantenimiento para Zeno Field

Paso Descripción
1. Inicie el gestor de licencias en su CS10/CS15 accediendo a 

Start\Programs\Zeno Tools\Licence Manager.
2. Introduzca las claves de licencia en base a los campos en la Zeno Connect 

pestaña.
O pulse Browse y explore el archivo de licencia. Así se rellenarán todas las 
claves incluidas automáticamente. los cuales son:

• Zeno GIS Clave: Permite CS10/CS15 para Zeno Connect
• Zeno Connect Clave: Licencia para Zeno Connect
• Clave CCP: Clave de mantenimiento para Zeno Connect

Pasos Descripción
1. Inicio Client License Manager en su Zeno 10/Zeno 15 pulsando 

Inicio\Programas\Zeno Herramientas\Client License Manager.
2. Introduzca sus licencias en los campos correspondientes en la página 

GS05/06.
O pulse Abrir y busque su fichero de licencia. Esto rellenará todas las licen-
cias adquiridas automáticamente.
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GLONASS Opción 
para GG02 plus 
SmartAntenna

En el gestor de licencias, también puede añadir una GLONASS opción para GG02 plus.

Paso Descripción
1. Inicie el gestor de licencias en su CS10/CS15 accediendo a 

Start\Programs\Zeno Tools\Licence Manager.
2. Introduzca las claves de licencia en los campos correspondientes en la GG02 

plus pestaña y la GLONASS licencia en el campo respectivo.
O pulse Browse y explore el archivo de licencia. Así se rellenarán todas las 
claves incluidas automáticamente.
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1.1.4 Paquetes de idiomas

Instalación de 
paquetes de 
idiomas

 El paquete de idioma está basado en una versión Zeno Field/Zeno Connect 
específica y solamente se podrá instalar en la versión correspondiente.

1.1.5 Instalación del sistema operativo WinCE6

 Después de instalar una nueva versión WinCE 6, deberá volver a instalar otras aplica-
ciones como Zeno Field/Zeno Connect.

Actualización de 
WinCE6 con el 
cargador de soft-
ware

Actualización de 
WinCE6 con el 
arranque

Paso Descripción
1. Descargue el Zeno Field/Zeno Connect paquete de idioma desde 

myWorld@Leica Geosystems (https://myworld.leica-geosystems.com). 
Lo encontrará en esta ruta: myDownloadsSoftware > Zeno Field/Zeno 
Connect.

2. Copie el archivo en Zeno 10/Zeno 15.
3. Haga doble clic en el archivo. El Zeno Field/Zeno Connect paquete de idioma 

se instalará. 

Paso Descripción
1. Descargue la versión más reciente de WinCE6 only Build desde 

myWorld@Leica Geosystems (https://myworld.leica-geosystems.com). 
Lo encontrará en esta ruta: myDownloadsGNSS Products > Zeno 
10/Zeno 15 > Software > WinCE only build

2. Copie los archivos en una tarjeta SD.
3. Introduzca la tarjeta SD en la ranura SD de Zeno 10/Zeno 15.
4. Haga doble clic en el acceso directo Loader.exe de su escritorio.

o bien
Asegúrese de que no hay ningún archivo oculto. Navegue hasta My 
Device\Windows\Loader.exe. Haga doble clic en Loader.exe.

Paso Descripción
1. Descargue la versión más reciente de WinCE6 only Build desde 

myWorld@Leica Geosystems (https://myworld.leica-geosystems.com). 
Lo encontrará en esta ruta: myDownloadsGNSS Products > Zeno 
10/Zeno 15 > Software > WinCE only build

2. Cree una carpeta denominada System en una tarjeta SD.
3. Copie el archivo a la carpeta System de la tarjeta SD.
4. Cambie el nombre del archivo a software.img.
5. Introduzca la tarjeta SD en la ranura SD de Zeno 10/Zeno 15.
6. Reinicie el Zeno 10/Zeno 15.

 Así Zeno 10/Zeno 15 se reiniciará varias veces hasta que la actualización de 
software haya finalizado. No interrumpa la actualización. Asegúrese de que 
haya disponible suficiente potencia de batería.
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1.2 Instalación en CS25
1.2.1 Activación de Licencia para Zeno Field/Zeno Connect en CS25

Entitlement ID El Entitlement ID es la clave para la activación inicial de la licencia así como para pedir 
opciónes adicionales de software o CCPs.
El Entitlement ID está compuesto por 25 caracteres alfanuméricos separados por 
guiónes, por ejemplo:

Entitlement ID: 00101-64466-00014-03624-4C34F
El Entitlement ID puede encontrarse en la Factura y en el Albarán del producto de 
software comprado. Adicionalmente, puede encontrarse un Entitlement Certificate, 
en pael o formato digital. (ej. documento HTML).
El Entitlement ID de un software nunca cambia y por lo tanto estos documentos deben 
mantenerse cuidadósamente.

Requisitos de Insta-
lación

Para instalar el software en un PC y activar las licencias, es necesario lo siguiente: 
• Conexión del PC a internet.
• La factura, albarán o Entitlement Certificate con el Entitlement ID del software.
• La descarga del programa de instalación del software.
• Podrá encontrarlo en myWorld: my Downloads\Software

Asistente de Insta-
lación

La instalación del software y su activación se efectua con un asistente de instalación 
que le guía automáticamente a través del proceso de instalación y activación.
Los pasos de instalación descritos podrían diferir ligéramente dependiendo del soft-
ware a instalar.

Instalación y activa-
ción 
paso a paso

Pasos Descripción
1. Inicio del Programa de Instalación

• Para comenzar con la instalación del software, ejecute el programa de 
instalación *Setup.exe desde el disco duro local.

2. Instalando los archivos necesarios
El programa de instalación comprobará automáticamente si los archivos 
necesarios están instalados.

• Si no, seleccione Instalar para instalar los programas que faltan. Los 
programas necesarios se instalarán ahora en el PC.

3.
El asistente de instalación del software ha iniciado.

• Seleccione Siguiente para comenzar la instalación del software.
4. Aceptar el Software Licence Agreement

Los términos en el Leica Geosystems Software Licence Agreement han de ser 
aceptados antes de que el software pueda ser instalado.

• Lea el Software Licence Agreement y seleccione "Acepto...".
• Seleccione Siguiente para continuar con la instalación.

5. Inicio del Asistente de Activación de la Licencia
Para activar su Entitlement ha de iniciar el Asistente de Activación de la 
Licencia.

• Pulse Siguiente para iniciar el Asistente de Activación de la Licencia.
• Compruebe Saltar Activación de la Licencia si tiene licencia activa de 

una versión previa del software o si prefiere activar la licencia poste-
riormente en el Licence Administrator.
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6. Inicio Proceso de Activación de la Licencia
El Proceso de Activación de la Licencia ha de ser iniciado:

• Pulse Siguinte para iniciar el Proceso de Activación de la Licencia.
• Si no se puede establecer una conexión a internet se mostrará la 

página Proxy Server .
7. Comprobando los Entitlements existentes

Si para el producto que esta instalando, se activó una licencia anteriormente, 
entonces se establecerá una conexión al Leica Geosystems servidor de licen-
cias para comprobar si existen actualizaciónes disponibles para su producto.

• Seleccione Siguiente para establecer la conexión al Leica Geosystems 
Servidor de Licencias.

• Por favor, espere mientras se completa la comprobación. Si la conexión 
a internet es lenta, esto podría llevar varios minutos.

• Si no se puede establecer una conexión a internet se mostrará la 
página del Proxy Server.

8. Introducción del Entitlement ID
Si la licencia del producto que va a instalar, no ha sido activada antes, 
entonces se pedirá que introduzca su Entitlement ID.

• Introduzca el Entitlement ID tal y como se refleja en la factura, albarán 
o Entitlement Certificate.

• Seleccione Siguiente para activar el Entitlement.
9. Registre el Entitlement

Se recomienda registrar el Entitlement en la Portal Web de Clientes myWorld.
• Seleccione Si, me gustaría registrarlo si desea registrar el Entitle-

ment ID immediatamente.
• Seleccione Siguiente para proceder. El navegador aparecerá con la 

página inicial de myWorld. Para más detalles de cómo registrar el Entit-
lement consulte "Registre la licencia en myWorld".

• Si selecciona No, no quiero registrarlo , podrá registrar el Entitle-
ment después. Consulte " Registre la licencia en myWorld".

10. Activación completada
El entitlement ha sido activado o actualizado correctamente.

• Seleccione Finalizar para cerrar el Asistente de Activación de la 
Licencia.

El Asistente de Activación de la Licencia se cerrará y la instalación del soft-
ware continua.
El Entitlement activado puede verse en cualquier momento en la Herramienta 
de Gestión de Licencias del CLM Administrator.

11. Seleccione una Carpeta de Destino para la instalación
Ahora, se ha seleccionado la ruta para la instalación del software.

• Seleccione Cambiar si desea instalar el software en otra ruta.
• Seleccione Siguiente para continuar con la instalación.

12.
Ahora puede iniciarse la instalación del software.

• Seleccione Instalar para comenzar la instalación del software.
El software se instalará en el directorio seleccionado.

13. Instalación completada
Después de que haya finalizado la instalación del software.

• Seleccione Finalizar para salir del Asistente de Instalación e iniciar el 
software.

Pasos Descripción
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Registre la licencia 
en myWorld

En caso de fallo en 
la activación...

En caso de que falle la activación de la licencia: 
• contacte con su proveedor Leica Geosystems local.
O bien
• introduzca un nuevo incidente de soporte en myWorld.leica-geosystems.com que 

será respondido por su equipo de soporte de Leica Geosystems.

Pasos Descripción

 Es necesario registrar las licencias en el Portal Web de Clientes myWorld para 
poder hacer el rehosting y para acceder a la información del producto y 
actualizaciónes de software. Para registrar las licencias es necesario el Entit-
lement ID.
El registro de licencias puede efectuarse durente la instalación, pero también 
a posteriori.

1. Inicio de myWorld
myWorld puede iniciarse mediante el siguiente link:

• http://myworld.leica-geosystems.com
• Si seleccionó Si, me gustaría registrarlo durente la instalación, 

myWorld se iniciará automáticamente en una ventana de navegador 
independiente.

• myWorld también puede iniciarse directamente desde el CLM Adminis-
trator seleccionando Registrar Entitlement después seleccionar Ver 
Licencias Instaladas y después Devolver Licencias.

Si ya dispone de un usuario y password para myWorld puede acceder direc-
tamente:

• Introduzca su E-Mail y Password y seleccione Entrar.
Si no tiene un usuario y password para myWorld necesita registrarse como 
nuevo usuario de myWorld:

• Seleccione Registrar para iniciar el Asistente de Registro de myWorld.
• Siga el Asistente de Registro hasta que lo complete y recibirá su 

usuario y password vía E-Mail.
• Introduzca su E-Mail y Password y seleccione Entrar. 

2. Inicio de myProducts
El registro de la licencia a su usuario (ej. empresa) se hace vía myProducts. 
Iniciar myProducts:

• Seleccione myPrdoucts desde el menu de la izquierda.
3. Añadir Producto

myProducts muestra todos Leica Geosystems los productos que estan regis-
trados al usuario actual. Añadir un producto o licencia adicional:

• Seleccione Añadir Producto desde el botón bajo la lista de productos.
4. Registrar Licencia

Añadir una licencia:
• Seleccione Software. Introduzca el Entitlement ID. Seleccione OK.

Ahora, la licencia ha sido registrada y el software añadido a la lista de myPro-
ducts.



Zeno GIS, Instalación y licencia de Zeno Field y Zeno Connect 11

1.2.2 Gestión de licencias

Inicio del adminis-
trador de licencias

Utilice un administrador de licencias separado para gestionar la licencias de CS25.

Vista de licencias Utilice View Installed Licences para visualizar las licencias activadas en la actualidad en 
CS25. No necesita tener conexión a Internet para visualizar las licencias.

Paso Descripción
1. Seleccione Start MenuAll Programs > Leica GeosystemsClient 

Licence ManagerLicence Administrator.

El cuadro de diálogo View 
Installed Licences presenta:

• Código de licencia
• Todas las opciones acti-

vadas en la actualidad 
en el paquete de soft-
ware
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Activación de las 
opciones de soft-
ware o manteni-
miento de software

Paso Descripción

 Se necesita una conexión a Internet para permitir la conexión con el Leica 
Geosystems servidor de licencias.

1. Ir a View Installed Licences.
2. Asegúrese de que el PC esté conectado a Internet.
3. Haga clic en Check for updates en el botón derecho.

Se establecerá una conexión con el Leica Geosystems servidor de licencias y 
se iniciará la comprobación de actualizaciones de licencias.

Ninguna actualización de licencia 
disponible

Actualizaciones de licencia dispo-
nibles

4. Aparecerá este mensaje: No new 
licences are available.
Haga clic en OK.

Aparecerá el mensaje xxx newly 
available activatable licences.
Seleccione Activate new licences en el 
botón derecho del sitio.
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1.2.3 Transferir licencias a otro PC (rehosting)

Transferir licencias La transferencia de una licencia un PC a otro se denomina rehosting.

Paso Descripción

 Para realizar este proceso, deberá estar registrada la licencia en myWorld. 
Consultar "Registre la licencia en myWorld".

1. Seleccione Start MenuAll Programs > Leica GeosystemsClient 
Licence ManagerLicence Administrator.

2. Ir a View Installed Licences.
Se presentan los códigos de licencia de las licencias activadas en la actua-
lidad.

3. Asegúrese de que el PC esté conectado a Internet.
4. Seleccione el código de licencia que desea devolver.
5. Haga clic en Return Licences.

Se mostrarán las licencias seleccionadas para su devolución.

Las licencias están registradas en 
myWorld

Las licencias NO están registradas 
en myWorld

6. Haga clic en Continue para confirmar 
la devolución de las licencias seleccio-
nadas.

Haga clic en Register Entitlements.

Se establecerá una conexión con el Leica Geosystems servidor de licencias y 
se devolverán las licencias seleccionadas.

7. Siga la instalación completa y el proceso de activación en un PC diferente. 
Consulte "1.2.1 Activación de Licencia para Zeno Field/Zeno Connect en 
CS25" para más información.
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1.2.4 Paquetes de idiomas

Instalación de 
paquetes de 
idiomas

 El paquete de idioma está basado en una versión Zeno Field/Zeno Connect 
específica y solamente se podrá instalar en la versión correspondiente.

Paso Descripción
1. Descargue el Zeno Field/Zeno Connect paquete de idioma desde 

myWorld@Leica Geosystems (https://myworld.leica-geosystems.com). 
Lo encontrará en esta ruta: myDownloadsSoftware > Zeno Field/Zeno 
Connect.

2. Copie el archivo en CS25.
3. Haga doble clic en el archivo. Siga las instrucciones del asistente de instala-

ción.
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1.3 Instalación y licencia en Zeno 5
1.3.1 Instalación para Windows Mobile Embedded Professional 6.5

Instalación Paso Descripción

 Windows Embedded Handheld 6.5 está pre-instalado en inglés. Siga las 
instrucciones de instalación del sistema operativo en otro idioma.

1. Asegúrese de que la batería esté totalmente cargada antes de su uso.
2. Conecte el módulo USB SnapOn al Zeno 5.
3. Enchufe el microUSB al adaptador USB.

4. Encender el Zeno 5.
5. Después de reiniciar el Zeno 5, enchufe la Leica Zeno llave USB.
6. Seleccione el país en la siguiente pantalla. Este paso afectará al idioma de 

instalación.
7. El menú de instalación aparecerá.
8. Seleccione Windows Embedded Handheld 6.5.

 Durante la instalación, el Zeno 5 se reiniciará varias veces. No interrumpa el 
proceso de instalación.

9. Después de finalizar con la instalación, desenchufe la Leica Zeno llave USB.

 Para volver a acceder al menú del cargador USB, enchufe de nuevo la unidad 
USB.
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1.3.2 Zeno Field/Zeno Connect

Instalación Zeno 
Connect/Zeno Field 
en Zeno 5

Paso Descripción
1. Asegúrese de que la batería esté totalmente cargada antes de su uso.
2. Conecte el módulo USB SnapOn al Zeno 5.
3. Enchufe el microUSB al adaptador USB.

4. Encender el Zeno 5.
5. Después de reiniciar el Zeno 5, enchufe la Leica Zeno llave USB.
6. Seleccione el país en la siguiente pantalla. Este paso afectará al idioma de 

instalación.
7. El menú de instalación aparecerá.
8. Seleccione Zeno Field/Zeno Connect.
9. Después de finalizar con la instalación, desenchufe la Leica Zeno llave USB.

 Para volver a acceder al menú del cargador USB, enchufe de nuevo la unidad 
USB.
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1.3.3 Activación de licencia para Zeno Field/Zeno Connect en Zeno 5

Licencia de Zeno 
Field/Zeno Connect

Para utilizar Zeno Field y Zeno Connect se necesita una licencia válida.
Puede registrar licencias en el gestor de licencias para:

• Zeno Field: Zeno Field licencia, Zeno GIS clave, claves CCP
• Zeno Connect: Zeno Connect licencia
• GG02 plus: GLONASS opción

Todos los Zeno dispositivos se suministran con claves de licencias pre-instaladas. 
Además, recibirá las teclas en formato impreso. En algunos casos deberá registrar las 
claves nuevas de licencias, por ejemplo en caso de que haya caducado la clave de una 
licencia CCP.

Cómo registrar una 
licencia de 
Zeno Field

Cómo registrar una 
licencia de 
Zeno Connect

GLONASS Opción 
para GG02 plus 
SmartAntenna

En el gestor de licencias, también puede añadir una GLONASS opción para GG02 plus.

Paso Descripción
1. Inicie el gestor de licencias en el Zeno 5 accediendo al botón de 

Windows\Zeno Tools\Licence Manager.
2. Introduzca sus claves de licencia en los campos correspondientes de la Zeno 

Field pestaña.
O pulse Browse y explore el archivo de licencia. Así se rellenarán todas las 
claves incluidas automáticamente. los cuales son:

• Zeno Field Clave: Licencia para Zeno Field
• Clave CCP: Clave de mantenimiento para Zeno Field

Paso Descripción
1. Inicie el gestor de licencias en el Zeno 5 accediendo al botón de 

Windows\Zeno Tools\Licence Manager.
2. Introduzca sus claves de licencia en los campos correspondientes de la Zeno 

Connect pestaña.
O pulse Browse y explore el archivo de licencia. Así se rellenarán todas las 
claves incluidas automáticamente. los cuales son:

• Zeno Connect Clave: Licencia para Zeno Connect

Paso Descripción
1. Inicie el gestor de licencias en el Zeno 5 accediendo al botón de 

Windows\Zeno Tools\Licence Manager.
2. Introduzca las claves de licencia en los campos correspondientes en la GG02 

plus pestaña y la GLONASS licencia en el campo respectivo.
O pulse Browse y explore el archivo de licencia. Así se rellenarán todas las 
claves incluidas automáticamente.
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2 Creación de proyecto
2.1 Zeno Office

Funcionalidad de 
Zeno Office

Zeno Office y Zeno Office en ArcGISTM son paquetes de software para mantener, 
gestionar y post-procesar GIS, GNSS y realizar muestreos de datos.

Herramientas de Zeno Office y Zeno Office en ArcGISTM:
• Flujos de trabajo automatizados en oficina y exteriores EasyIn y EasyOut
• Guardado de información de calidad GNSS detallada en una GIS base de datos
• Integración de mediciones de muestreo en una GIS base de datos

2.1.1 Asistente

Creación de un 
proyecto

Utilice el asistente del proyecto para definir:
• Sistemas de coordenadas
• Transformaciones
• Modelos de datos

Paso Descripción
1. Iniciar Zeno Office o Zeno Office en ArcGIS TM.
2. Haga clic en File > New Project e introduzca un nombre de proyecto. Si falta 

un proyecto nuevo en el menú de archivo, añádalo desde el cuadro de 
diálogo Customize.

3. Seleccione el tipo de base de datos:
Geobase de datos personal

• Utilizada para trabajos de un solo usuario con conjuntos más 
pequeños GIS de datos

• Basado en un único archivo Microsoft Access *.mdb
• Tamaño máximo de archivo de 2 GB
• Sin edición multi-usuario, traducción o archivo histórico

Archivo de geobase de datos
• Utilizado para trabajos de un solo usuario con conjuntos medianos GIS 

de datos
• Almacenamiento en un archivo de sistema
• Sin límite de tamaño. Por defecto: 1 TB por tabla
• Rendimiento superior que en geobases de datos personales
• Los datos del vector se pueden comprimir en un formato de solo 

lectura para conseguir un rendimiento superior de la geobase de 
datos

• Admite múltiples editores simultáneamente al editar diferentes 
tablas, categorías de características o conjuntos de datos de caracte-
rísticas

• Sin traducción o archivado histórico
• Recomendado al iniciar nuevos GIS proyectos para su uso local propio
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4. Examine una ruta de un proyecto.
5. Introduzca una descripción del proyecto (opcional), por ejemplo el nombre 

y localización del muestreador.

 Si quiere volver a utilizar los ajustes de otro proyecto, defina la plantilla del 
mapa.

6. Haga clic en Next.
7. Haga clic en Select para definir un sistema de coordinadas y examine el 

sistema deseado de coordenadas.

8. Haga clic en Add. 
9. Haga clic en Next.

 Es posible editar las propiedades del paquete de muestreo. Pasos 10. a 17. 
son un ejemplo de cómo cambiar los Leica GNSS ajustes del modelo de 
datos. Los Leica GNSS ajustes del modelo de datos definen:

• Transformaciones
• Modelos geoides
• Modelos CSCS

10. Resalte Select Leica GNSS modelo de datos y haga clic en ajustes....

11. Haga clic en Select... en la pestaña de transformación y elija un ajuste de 
transformación.

Paso Descripción
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12. Están disponibles las transformaciones predefinidas dependiendo del 
sistema de coordenadas. Las opciones son las siguientes:

• Seleccione una de las transformaciones predefinidas. Continuar con 
el paso 14..

• Haga clic en Modify para personalizar los parámetros de transforma-
ción. Continuar con el paso 13..

• Haga clic en New... para crear una nueva transformación. Continuar 
con el paso 13..

13. a) Introduzca un nombre y una descripción.
b) Seleccione el tipo de transformación.

 Con Zeno Office v3.0 o superior, Leica Bursa-Wolf (7 parámetros) y 
Leica Molodensky-Badekas (10 parámetros) están incluidos.

 Si ya ha utilizado las transformaciones Coordinate Frame, Position 
Vector o Geocentric Translation, ahora deberá seleccionar las trans-
formaciones Leica Bursa-Wolf.

 Las transformaciones en proyectos existentes se convierten auto-
máticamente en Leica Bursa-Wolf y producirán exactamente los 
mismos resultados.

c) Introduzca o edite los parámetros de transformación.
d) Seleccione un archivo geoide o CSCS (opcional). Verifique la casilla de selec-

ción situada al lado de Use Geoid File o Use Grid File: Leica CSCS y 
explore el archivo.

 Con Zeno Office/Zeno Field v3.0, se admiten los archivo geoides y 
CSCS directamente en Zeno Office/Zeno Field. Los archivos geoides 
y CSCS se transfieren y se aplican automáticamente en el dispositivo 
móvil por EasyOut.

Paso Descripción
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14. Haga clic en OK.
15. Es posible fijar una transformación por defecto. La transformación por 

defecto se utilizará automáticamente en el sistema específico de coorde-
nadas en el asistente la próxima vez.
Para fijar una transformación por defecto (opcional):

Resalte la transformación y haga clic en Set Default. La transformación 
estará marcada con un * a la izquierda del nombre. La transformación por 
defecto se utilizará automáticamente en este sistema específico de coordi-
nadas en el asistente la próxima vez.
La transformación estará marcada con un * a la izquierda del nombre.

16. Haga clic en OK para volver a los ajustes del Leica GNSS modelo de datos.
17. Haga clic en OK para volver a las propiedades de los paquetes de muestreo.

Ahora su transformación estará definida y puede continuar con los 
siguientes pasos del asistente del proyecto.

18. Haga clic en Next.

Paso Descripción
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19. • Para crear nuevas categorías de características:
Haga clic en el primer campo vacío de nombre e introduzca un nombre.
Añada una descripción de la categoría de características en el campo 
Alias Name (opcional).
Cree más categorías de características haciendo doble clic en el campo 
Geometry y seleccione el tipo de geometría deseada, por ejemplo, Point, 
Polyline o Polygon.

• Para importar nuevos esquemas de categorías de características:
Haga clic en Import.

20. Verifique la casilla de selección 3D para guardar valores de altura en las 
características.

21. Para añadir atributos de las categorías de características:
a) Haga clic en la columna principal de una categoría de características para 

seleccionarla.
b) Haga clic derecho en la columna principal y seleccione Edit Attributes....

Paso Descripción
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c) Introduzca un nombre de campo en la siguiente línea libre.
Haga clic en Data Type Field y seleccione el tipo de datos, por ejemplo, Text, 
Double o Raster.

 Para guardar las imágenes como atributos en los datos, cree un 
campo de texto. Designe la fotografía, imagen o dibujo del campo de 
texto. Asigne una longitud mínima de 20 caracteres. Este campo de 
texto se utiliza para guardar el enlace de la imagen en Zeno Field.

22. Repetir el paso 20. en todas las categorías de características
23. Haga clic en OK.
24. Haga clic en Finish después de haber definido todas las categorías de carac-

terísticas y campos de atributos.
Se ha creado el proyecto.

 El proyecto se puede utilizar como plantilla.

Paso Descripción
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2.1.2 Ajustes de imagen

Base de hiperenlace EasyIn transferirá automáticamente las imágenes recogidas al PC de su oficina. Estas 
imágenes se guardan en una localización definida en la base del hiperenlace.

Ajustes de capas de 
hiperenlace

Las imágenes enlazadas con una características se pueden visualizar en Zeno Office 
haciendo clic  en la barra de herramientas Tools. El soporte del hiperenlace se 

deberá definir en cada capa que muestre imágenes.

Paso Descripción
1. Haga clic en FileDocument Properties....
2. Introduzca la ruta en el campo de la base del hiperenlace, por ejemplo 

c:\images.

 Asegúrese de que la ruta definida exista en su sistema. Si no existe 
la ruta durante Easyln, las imágenes se copiarán en la carpeta del 
documento del mapa.

 Si las imágenes se guardaron en otra carpeta diferente, puede 
definir el ajuste de la base del hiperenlace del mapa.

Paso Descripción
1. Haga clic derecho en una capa de la pestaña Display del TOC y seleccione 

Properties....

2. Pase a la pestaña Display.
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3. Verifique Support Hyperlinks con el campo: 

4. Seleccione el campo donde se incluye el enlace de la imagen por ejemplo 
fotografía o imagen.

5. Haga clic en OK.
6. Repita este paso en todas las capas que incluyan imágenes.
7. Guarde el mapa.

 Puede utilizar el proyecto como plantilla de mapa en el asistente del 
proyecto al crear un nuevo proyecto.

Paso Descripción
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2.1.3 Transferencia de un proyecto entre Zeno Office y Zeno Field con 
EasyOut

Transferencia de un 
proyecto desde 
Zeno Office hasta 
Zeno Field

Con el EasyOut proceso puede transferir un Zeno Office proyecto a Zeno Office.

 Para exportar una base de datos no creada con el asistente del proyecto, 
deberá crear un conjunto de datos de muestreo manualmente. Consulte Zeno 
Office la ayuda de Office.

 El EasyOut proceso funciona exclusivamente desde una sola geobase de datos.
Asegúrese de que todos los datos cuenta con la misma referencia espacial.
Si su proyecto incluye datos de diferentes geobases de datos o las categorías 
de características tienen sistemas diferentes de coordinadas, aparecerá un 
mensaje.
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Paso Descripción
1.

Pulsar  en la Leica barra de herramientas Data Manager. Si no está 
disponible la barra de herramientas, seleccione Customise\Customise 
Mode en el menú Tools y marque la casilla de selección situada al lado de 
Leica Data Manager.

2. Verifique las casillas de selección tal y como se requiera:
• Check Out:

De las capas que quiera transferir a Zeno Field. Puede realizar medi-
ciones en Zeno Field. Las capas pueden volver a transferirse a Zeno 
Office.

• Copy Out:
De las capas que quiera utilizar de fondo del proyecto ya que las capas 
de fondo suelen ser de solo lectura (por defecto).
Se creará un archivo de forma. No podrá volver a introducirse con 
EasyIn.
Accessibility Read only: De los datos de fondo.
Accessibility Editable: Para modificar el archivo de forma en el campo.

3. Marque Check out only schema of data para fijar el esquema sin datos.
4. Seleccione la pantalla actual para exportar la extensión actual del mapa. 

También puede exportar solo las características seleccionadas o las zonas 
marcadas con un gráfico.

5. Introduzca un nombre del proyecto.
6. Explore la localización del proyecto. Puede navegar directamente por una 

conexión móvil o por la carpeta de intercambio de datos ActiveSync. 
7. Haga clic en OK.

El proyecto se ha transferido.

 Para Zeno Office/Zeno Field v3.0 o superior:
• Las transformaciones se transfieren automáticamente al Zeno dispo-

sitivo durante el EasyOut proceso. La herramienta Datum Configura-
tion ya no es necesaria.

• Los modelos geoides y CSCS se admiten directamente en Zeno Field.
• Revise el archivo geoide en la pestaña Coordinate System en GNSS  

Settings en Zeno Field. Consultar "2.2.2 Nuevo mapa". Si se ha reali-
zado un EasyOut proceso, no podrá editar el archivo geoide ya que ya 
estará definido en el Zeno Office proyecto.

Al utilizar versiones Zeno Office/Zeno Field inferiores a v3.0, las transforma-
ciones se aplicarán manualmente al Zeno dispositivo con la herramienta 
Datum Configuration. Consultar "2.2.3 Aplique una transformación al Zeno".
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2.2 Zeno Field

Funcionalidad de 
Zeno Field

Leica Zeno Field es una versión de ArcPad10. Zeno Field también ofrece a la ArcPad 
funcionalidad TM:

• GNSS registros de datos brutos
• Manejo sencillo de GNSS configuraciones, por ejemplo ajustes DGPS
• Gestión precisa de características
• Flujo de trabajo automatizado entre el campo y la oficina

Utilice Zeno Office para gestionar la calidad de la característica con tiempo y benefí-
ciese de las funciones automatizadas de importar y exportar a una amplia gama de 
formatos diferentes como ArcGIS geobase de datos, shapefile, dxf, dgn y dwg.

Leica Zeno Field se puede utilizar en:
• Mapeado de campo
• Inventarios de valores
• Mantenimiento de valores
• Inspecciones
• Informes de incidentes
• GIS Análisis y toma de decisiones

2.2.1 Mapa existente

Apertura de mapa 
existente

Paso Descripción
1. Inicie Zeno Field.
2. Haga clic en Choose map para abrirlo.

Aparecerá el cuadro de diálogo Open Map.

3. Abra un mapa existente. Es posible crear un mapa Zeno Field en Zeno Office.

 Se guardarán los proyectos listados en una ruta de datos por defectos en el 
cuadro de diálogo Open Map. Para cambiar esta ruta, diríjase Zeno Field a 
Options > Paths.
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2.2.2 Nuevo mapa

Crear un nuevo 
mapa

Paso Descripción
1. Inicie Zeno Field.
2. Cierre el cuadro de diálogo Open Map o seleccione un nuevo mapa.
3. Seleccione un sistema de coordenadas:

En Zeno Field necesitará un archivo *.prj en el que está almacenada la infor-
mación del sistema de coordinadas. 
Localización del archivo *.prj en su PC: En la carpeta Coordinate Systems en 
el directorio de instalación de Zeno Office.
Copie el archivo *.prj deseado al Zeno dispositivo.

4.
Tocar  para abrir Table of Contents.

5.
Tocar  en la barra de herramientas derecha.
Seleccione el archivo *.prj que copió previamente al Zeno dispositivo.

6. Haga clic en OK para salir de Table of Contents y guardar su mapa. 
7.

Tab  para guardar el mapa.
8. Opcional para Zeno Field v3.0 o superior:

Añada un archivo geoide para alcanzar alturas ortométricas de alta preci-
sión. Todos los valores de altura se basan en geoides.

 Un archivo geoide solamente se puede añadir en caso de que no 
haya otro archivo de este tipo adjuntado por el EasyOut proceso.

 Los geoides no se admiten en Zeno 5 al utilizar Sirf-GPS interno.
a) Abra GNSS Settings.
b) Pase a Coord.Pestaña de sistema.
c) Verifique Use Geoid File y explore su archivo geoide.

9. Ahora el documento del mapa estará listo y podrá crear los mismos shape-
files. En shapefiles podrá guardar puntos, polígonos o geometría de polilínea 
además de atributos adicionales. Pulse New y después Shapefile.
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10. Escoja entre la geometría Point, Polyline y Polygon en el cuadro combi-
nado Type.
Pulse + en la parte inferior de la página para añadir algunos campos de atri-
butos al shapefile.

11. Escoja un nombre para el campo de atributo, seleccione un tipo de datos y 
defina la altura y precisión. Acepte los ajustes con OK.

 Para guardar las imágenes como atributos en los datos, cree un 
campo de texto. Designe la fotografía, imagen o dibujo del campo de 
texto. Asigne una longitud mínima de 20 caracteres. Este campo de 
texto se utiliza para guardar el enlace de la imagen en Zeno Field.

12. Repetir el paso 10. y 11. para definir otros atributos.

Paso Descripción
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13. Pulse OK. Escoja un nombre para el shapefile y guárdelo.

14. Después de guardar el shapefile, Zeno Field deberá crear un Quickform.
¿Qué es Quickform?
Para facilitar la captura de datos en el campo, puede crear formas de 
entrada personalizada para cada shapefile en Zeno Field. QuickForms suelen 
incluir funciones básicas y opciones de creación de formas en el campo 
cuando no tenga acceso al escritorio de su PC.

15. Pulse Yes.
16. Edite el QuickForm en base a sus necesidades.

Por ejemplo, puede especificar las pestañas que hay que incluir, definir 
valores mínimos y máximos, crear valores predefinidos que aparecerán en el 
menú desplegable (delimitados por coma, sin espacios).

17. Repetir el paso 9. a 16. para crear más shapefiles.

Paso Descripción
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Crear un 
QuickProject

Paso Descripción
1. Inicie Zeno Field.
2. Pulse NewQuickProject...

3. Seleccione una plantilla:
Elija una plantilla con la que se creará el QuickProject con capas basadas en 
las capas de la plantilla. Zeno Field viene con cuatro plantillas de muestra que 
se pueden utilizar en lugar de la plantilla por defecto.

4. Seleccione una proyección.

 Una plantilla incluye
• un archivo *.zip con todas las capas que forman la plantilla.
• un archivo apm denominado Template.apm que hace referencia a todos 

los archivos de estas capas.
Puede crear su propia plantilla en cualquier capa.
Las capas pueden ser shapefiles, AXF o capas de cuadrícula.

 También puede adjuntar un archivo geoide. Consulte el "Crear un nuevo mapa" 
paso 8..
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2.2.3 Aplique una transformación al Zeno

 Debe utilizar la herramienta Datum Configuration y transferir la transformación a su 
Zeno dispositivo en caso de

• que la versión Zeno Office sea inferior a v3.0.
• que la versión Zeno Field sea inferior a v3.0.
• que no EasyOutse haya realizado desde Zeno Office.

Funcionalidad de la 
herramienta Datum 
Configuration

La herramienta Datum Configuration está instalada con Zeno Field en el escritorio del 
PC y CS25. En esta sección es posible:

• Defina nuevos ajustes de transformación entre las dos fechas
• Seleccione las transformaciones por defecto
• Copie los archivos de transformación a Zeno

La herramienta Datum Configuration escribe las ediciones en dos archivos *.dbf. 
Ambos archivos deben copiarse manualmente a su Zeno dispositivo.

Aplicación de una 
transformación al 
Zeno con la herra-
mienta Datum 
Configuration

Paso Descripción

 Solamente debe realizar este proceso una vez. La transformación correcta 
se utilizará automáticamente en cada mapa que utilice la fecha asociada.

1. Abra la herramienta Datum Configuration en StartAll ProgramsLeica 
GeosystemsLeicaZeno FieldDatum Configuration Tool.
La herramienta Datum Configuration incluye dos pestañas:

• Defina la pestaña Datum Transformation para crear una transfor-
mación personalizada

• Seleccione la pestaña por defecto Datum Transformation para fijar 
una transformación por defecto

2. En pestaña Define Datum Transformation
Cree una nueva transformación personalizada:

a) Elija un nombre para la transformación.
b) Seleccione un método Datum Transformation.
c) Seleccione Datum 1 de la lista (en general WGS84).
d) Seleccione Datum 2 de destino de la lista.
e) Edite los parámetros de transformación.
f) Para una Zeno Field versión superior de v2.1

Añada un archivo CSCS:
Rellene el nombre del archivo CSCS en el campo Dataset. Por ejemplo, 
cuando su archivo CSCS sea Swiss.csc, rellene Swiss.
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3. Para Zeno Field versiones superiores a v2.1:
Para aplicar archivos NTv2 a la herramienta Datum Configuration, deberá 
convertirlos a archivos CSCS.

a) Seleccione StartAll ProgramsLeica GeosystemsZeno ToolsCSCS 
Model Converter

b) Seleccione NTv2 como formato de los datos.
c) Explore el archivo NTv2.
d) Seleccione una localización para el archivo CSCS generado.
e) Sustituya el archivo CSCS generado en el conjunto de datos.  Consulte 2..

4. Haga clic en Save para guardar la transformación.
5. Pase a la pestaña Select Default Datum Transformation.
6. En la pestaña Select Default Datum Transformation

a) Seleccione Datum y Associated Datum.
Aparecerá un lista de todas las transformaciones disponibles entre ambas 
fechas.

b) Verifique la casilla de selección en la columna Default Transform para fijar 
los datos por defecto.
La transformación por defecto se utilizará automáticamente en todos los 
mapas que utilicen la fecha asociada.

c) Haga clic en Save para guardar la transformación por defecto.

Paso Descripción
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7. En la pantalla Manage tiene un resumen de todas las transformaciones 
personalizables.

8. Copie el archivo transform.dbf y defaulttransform.dbf de su PC al Zeno. 
Localizaciones de archivo:

• Para Zeno Field v1.0:
C:\Program Files\Leica Geosystems\Leica Zeno Field\System\

• Para Zeno Field v1.1 o versiones superiores:
C:\Documents and Settings\All Users\Documents\ArcPad\System\

9. Introduzca ambos archivos en la carpeta:
• Para Zeno 5/Zeno 10/Zeno 15:

\Program Files\Zeno Field\System
• Para CS25:

C:\Users\Public\Public Documents\Zeno Field\System
10. Para Zeno Field versiones superiores a v2.1 y un archivo CSCS definido en la 

herramienta Datum Configuration:
a) Compruebe que el archivo esté incluido en la carpeta del proyecto (misma 

localización que el archivo *.apm).
b) El nombre del archivo CSCS debe ser idéntico al nombre especificado en la 

herramienta Datum Configuration.
c) El archivo CSCS se aplicará al iniciar el proyecto en Zeno Field. Además, el 

archivo quedará copiado en la carpeta CSCS Models.
11. Abra Zeno Field para revisar los parámetros de transformación utilizados.
12. Abra el GPS cuadro de diálogo Preferences.

Pase a la pestaña Datum.
13. Pulse el icono Info.

Paso Descripción
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14. Aparecerá información detallada de transformación.
Revise los CSCS usados en línea al empezar con el conjunto de datos.

Paso Descripción
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3 Trabajando con Zeno Field
3.1 Edición en Zeno Field
3.1.1 Teclas en Zeno 10/Zeno 15

Teclado del CS10

Teclado del CS15

a) Inicio
b) ON/OFF
c) Teclas de dirección OK
d) Fn
e) Tecla ±
f) Brillo
g) Favoritos
h) ESC
i) Enter
j) Retroceso
k) Volumen
l) Teclas numéricas

2 31

.

5 64 

8 97

0 

Fn

ABC DEF

GHI JKL MNO

PQRS TUV WXYZ

OK

000176_004

e

f

g

d

a

b
c

h

i

j

k

l

a) Inicio
b) Teclas de dirección OK
c) ON/OFF
d) Fn
e) Tecla ±
f) Teclas numéricas
g) Brillo
h) Teclas de función F7 - F12
i) Bloq Mayús
j) Teclas de función F1 - F6
k) Favoritos
l) ESC
m) ENTER
n) Retroceso
o) Volumen
p) Teclas alfabéticas
q) ENTER
r) Espacio

F1 F2

F7

F8

F9 F10

F11

F12

F3 F4 F5 F6

.

2 31

54

Fn

6

8 97

0 

Q W E R T Y U I O P 

L K J H G F D S A 

Z X C V B N M 

OK

000177_005

e

g

h

c

a
b

d

f

i

j

k

l
m

n

o

p

q

r
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Teclas Tecla Función
Medición

Cambia el tipo de geometría de Point to Polyline a Polygon.

Zoom completo

Acercar

Alejar

Centre el mapa en GPS posición (panorámica automática encen-
dida/apagada)
Actualizar mapa

Mueven el cursor por la pantalla.

OK en todos los diálogos.

1

2

3

5

0

OK

OK
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3.1.2 Teclas en Zeno 5

Teclado en pantalla 

Teclas

a) Teclas de dirección
b) Tecla de llamada
c) Teclas de escaneo
d) Tecla de Windows
e) Teclas alfa/caracteres especiales
f) SHIFT
g) ESC/CTRL
h) Asterisco
i) Teclas numéricas
j) Tecla final
k) Tecla de encendido
l) Teclas de función
m) ENTER
n) Retroceso/DEL
o) TAB/ALT
p) Modificador BLUE/FN
q) SYM
r) Espacio

Y U I O P 

L K J H G F D S A 

Z X C V B N M 
.

Q W E R T 

ESC , SYM TAB 

<

<

<
<

2 31

54 6
8 97
0 

F1 F2

F7 F8

F9 F10

F3 F4

F5 F6

CTRL # ALT àü

? DEL OK

:= +
_@

/

003900_001

a
b
c c
d

e

f

g
h
i

j

k

l

m

n
o
p
q
r

Tecla Función
Medición
• Izquierda/derecha: Panorámica a la izquierda/derecha
• Arriba: Alejar
• Abajo: Acercar
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3.1.3 Teclas en CS25

Teclado del CS25

Teclas

a) Indicadores LED
b) ON/OFF
c) Menu
d) Teclas de flecha, OK
e) Teclas de función

CS25_004

a
b
c

e

d

Tecla Función
ON/OFF Si el CS25 está apagado: Se enciende CS25 al mantener 

pulsado durante 5 s.
Si el CS25 está encendido:
• Se pone CS25 en modo de pausa al mantener pulsado 

durante < 4 s.
• Se apaga CS25 al mantener pulsado durante 8 s.

Menu IniciaMenu las opciones del botón.

Teclas de dirección Mueven el cursor por la pantalla.

OK Selecciona la línea resaltada y conduce al siguiente menú / 
diálogo .

Teclas de función
F1-F3

Teclas de acceso rápido programables.
F2 cortas: Mida una característica en Zeno Field v3.11 o 
superior
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3.1.4 Creación de características

Creación de carac-
terística de un 
punto por digitaliza-
ción

Creación de una 
característica de 
polilíneas por digi-
talización

Paso Descripción
1. Pulse el botón Start/Stop Editing en la barra de herramientas Edit.

La lista desplegable presenta todas las capas editables del mapa actual.

2. Seleccione una capa de puntos para su edición.

 Puede seleccionar un punto, una línea, una capa poligonal para su edición a la 
vez.

3. Tocar  en la barra de herramientas Edit para comenzar a capturar una carac-
terística de puntos.

4. Tocar  en el mapa.
5. Introduzca los atributos de la nueva característica de puntos.

Paso Descripción
1. Pulse el botón Start/Stop Editing en la barra de herramientas Edit.

La lista desplegable presenta todas las capas editables del mapa actual.

2. Seleccione una capa de línea para su edición.
3. Tocar  en la barra de herramientas Edit para comenzar a capturar una carac-

terística de líneas.
4. Pulse en el mapa para crear vértices.
5. Tocar  para completar la captura.
6. Introduzca los atributos de la nueva característica de línea.
7. Pulse OK.
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Creación de una 
característica de 
polígono por digita-
lización

Paso Descripción
1. Pulse el botón Start/Stop Editing en la barra de herramientas Edit.

La lista desplegable presenta todas las capas editables del mapa actual.

2. Seleccione una capa de polígono para su edición.
3. Tocar  en la barra de herramientas Edit para comenzar con la captura de una 

característica de polígono.
4. Pulse en el mapa para crear vértices.
5. Tocar  para completar la captura.
6. Introduzca los atributos de la nueva característica de polígono.
7. Pulse OK.
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Creación de carac-
terísticas con la 
barra de herra-
mientas 
QuickCapture

¿Qué es QuickCapture?
• QuickCapture está disponible en Zeno Field v2.0 o versiones superiores. 
• QuickCapture es una barra de herramientas que ofrece la posibilidad de crear 

nuevas características en los mapas con un solo clic. 
• La barra de herramientas hacer QuickCapture es dinámica. El contenido se 

define con las capas abiertas del mapa. 

Paso Descripción
1. Abra un proyecto existente o comience con QuickProject.
2.

Tocar .
3. Las tres primeras categorías están representadas en la barra de herramientas 

por defecto, si la capa cuenta con categorías de simbología definidas como en 
el caso de QuickProject.

4. Después de seleccionar una característica, estará preparado para editar.

 Pulse  en la barra de herramientas Command para finalizar las caracterís-
ticas del polígono o polilínea.

5. Introduzca los atributos de una nueva característica.

 Puede definir las herramientas que aparecerán en la barra de herramientas 
QuickCapture verificando/desverificando las categorías simbólicas en la 
pestaña QuickCapture en el cuadro de diálogo Table of Contents. 
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3.2 GNSS Ajustes
3.2.1 GPS Preferencias

Edición de GPS 
preferencias

En Leica Zeno Field las GPS preferencias ya están preconfiguradas. La conexión del 
Zeno GNSS módulo está garantizada automáticamente. 

Paso Descripción
1. Abra el GPS menú desplegable. Seleccione GPS Preferences.

2. Vaya a la pestaña Capture.

Active Averaging:
• Verifique la casilla de selección para observaciones múltiples de una 

característica de punto o cada vértice de una línea/polígono.
• Se necesita un mínimo de cinco puntos o vértices para realizar una medi-

ción correcta.
Streaming:

• Se utiliza para realizar capturas de vértices continuos de una caracterís-
tica de polilínea o polígono al utilizar la herramienta Capture Vertices. 

• Position Interval: Se utiliza cada posición xGPS.
• Distance Interval: Se captura una posición después de desplazarse a la 

distancia especificada.
3. Pulse OK.
4. Vaya a la pestaña GPS Height.

Defina la altura de la antena sobre el suelo. Ejemplos:
• 1 m al sostener el dispositivo móvil en la mano
• 2 m al trabajar con el paquete de polos

5. Pulse OK.

 En la pestaña Quality puede definir las diferentes advertencias basadas en 
varios GNSS indicadores de calidad. En caso de sobrepasar los valores defi-
nidos, recibirá un mensaje.

 El error de posición estimada refleja la precisión actual en la GNSS barra de 
estado. EPE (error de posición) es la medición de calidad más conveniente. Si 
GNSS está activado el registro de datos brutos, EPE refleja la precisión esti-
mada post-procesada.
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3.2.2 Conectando a un GG03/GG02 plus

Conectando a 
GG02 plus/GG03

Paso Descripción
1. Inicie Zeno Field.
2. Abra el Zeno Field menú desplegable. Seleccione GNSS Settings.

3. Escoja un GG02 plus o GG03.

Dependiendo del dispositivo utilizado, se puede escoger diferentes sensores.
• Para GG02 plus/GG03 SmartAntenna:

Puede escoger un ángulo de corte.
• Para CS25 GNSS:

Seleccione una antena externa en un ajuste adicional.
4. Cambie en el SmartAntenna. Conecte con un cable (GEV162) si no quiere usar 

Bluetooth (opcional para Zeno 10/Zeno 15 y).
5.

Pulse .
6. En el cuadro de diálogo se presentan todas las antenas al alcance. Si la antena 

está conectada por cable, vaya a pestaña Cable.
7. Seleccione su antena. Se agrupará y conectará automáticamente.
8. Aparece un mensaje que indica que la conexión es correcta.

 La conexión de la antena solamente deberá hacerse la primera vez o al cambiar 
de antena. La antena se usará como dispositivo por defecto al activarla GNSS 
la próxima vez.

 Para cambiar una SmartAntenna a otra, asegúrese de que la antena previa esté 
apagada. Cambie a la nueva SmartAntenna y active GNSS. Aparecerá el cuadro 
de diálogo de búsqueda para seleccionar la nueva antena.
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3.2.3 Configuración de una fuente en tiempo real

Configuración por 
defecto

Para llevar a cabo el procesado en tiempo real, el sistema de aumento basado en saté-
lite ya viene preconfigurado y seleccionado automáticamente.
Para definir la información personalizada de conexión de su RTK, siga las instrucciones 
del presente capítulo.

 Si quiere post-procesar los datos más adelante en Zeno Office, deberá estar 
activado el registro de datos brutos.

Activación del registro de datos brutos:

Configuración de 
una fuente en 
tiempo real

Existen tres modos de recibir correcciones en un muestreo en tiempo real:
• Internet
• Por vía telefónica
• Radio/baliza

Paso Descripción
1. Abra el Zeno Field menú desplegable. Seleccione GNSS Settings.

2. Vaya a la pestaña Raw Data.
Verifique la casilla de selección de datos Log para el post-proceso.

 Al registrar los datos brutos en el Zeno 5 con el GPS interno, la media está 
fijada automáticamente en 180 s. Este ajuste garantiza un número suficiente 
de observaciones para conseguir resultados satisfactorios de post-proceso.
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Configuración de 
conexión a Internet

Paso Descripción
1.

Pulse .
2. Abra el Zeno Field menú desplegable. Seleccione GNSS Settings.
3.

Pulse  para iniciar el asistente New RTK Profile.
4. Introduzca el nombre de perfil y una descripción para guardar la configura-

ción de conexión para su uso futuro.
5. Seleccione Internet como tipo de conexión. Pulse Next.

6. Seleccione la conexión a Internet que utilizará:
• New Connection

Puede seleccionar el módem interno o inalámbrico, por ejemplo, telé-
fono móvil por Bluetooth. Continúe con 7..

• Active Connection
Puede ser WIFI, LAN o cualquier otra conexión a Internet disponible. 
Continúe con la sección "Configuración del servidor RTK".

7. Elija entre módem interno o externo.
• Internal Modem

Puede seleccionar el módem interno o inalámbrico, por ejemplo, telé-
fono móvil por Bluetooth.

• External Modem
Puede ser WIFI, LAN o cualquier otra conexión a Internet disponible.

Para módem interno Para módem externo
8. Introduzca el código PIN de la tarjeta 

SIM. Pulse Next.
Asegúrese de que su teléfono móvil 
esté encendido, el Bluetooth activado 
y el dispositivo preparado para ser 
encontrado.

9. - Pulse Search para buscar el disposi-
tivo móvil. Aparecerá una lista de 
todos los teléfonos con Bluetooth.
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10. - Seleccione su teléfono. Pulse Next.

11. - Introduzca una contraseña cual-
quiera, por ejemplo 123. Pulse Next. 
Confirme la contraseña en el disposi-
tivo móvil.

12. Aparecerá un mensaje que le indicará que la conexión se ha realizado correc-
tamente. Pulse Next.

13. Seleccione el tipo de conexión a Internet que quiera usar. Puede elegir entre 
las siguientes:

• GPRS/CDMA. Consultar "Configuración de una conexión GPRS/CDMA".
• CSD por vía telefónica. Consultar "Configuración de conexión a 

Internet por vía telefónica (CSD)".

Paso Descripción
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Configuración de 
una conexión 
GPRS/CDMA

Paso Descripción
1. Seleccione Using GPRS/CDMA Internet connection. Pulse Next.

 Dependiendo de su teléfono móvil, puede que sea necesario confirmar la 
conexión en el mismo. Añada el dispositivo a la lista de dispositivos cono-
cidos en su teléfono para evitarlo en la mayoría de los casos.

2. Introduzca la APN de su proveedor de servicios de Internet, por ejemplo, 
gprs.swisscom.ch. Pulse Next.

3. Introduzca su ID de usuario y contraseña de su conexión a Internet. Pulse 
Next.

4. Continúe con la sección "Configuración del servidor RTK".
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Configuración de 
conexión a Internet 
por vía telefónica 
(CSD)

Paso Descripción
1. SeleccioneUsing dial-up (CSD) Internet connection. Pulse Next.
2. Introduzca un nombre para guardar la información de la estación por vía 

telefónica para un uso futuro. Introduzca el número de teléfono de su 
proveedor de Internet y el tipo de protocolo utilizado en la conexión. Pulse 
Next.

3. Introduzca su ID de usuario y contraseña de su conexión a Internet. Pulse 
Next.
La información detallada de la estación por vía telefónica se puede obtener 
en su proveedor de servicios RTK.
También puede editar o borrar una estación por vía telefónica existente.

4. Introduzca su ID de usuario y contraseña de la conexión a Internet por vía 
telefónica. Pulse Next.

5. Continúe con la sección "Configuración del servidor RTK".
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Configuración del 
servidor RTK

Paso Descripción
1. Pulse New para crear un nuevo servidor.

 O en caso de estar disponible, seleccione un servidor RTK existente 
de la lista. Consulte 3..

2. Introduzca la información detallada del servidor RTK. Verifique NTRIP si 
desea utilizar NTRIP. Pulse Next.

 La información detallada puede obtenerse en su proveedor de servi-
cios RTK.

 También puede editar o borrar una configuración existente del 
servidor RTK.

3. Resalte el servidor nuevo creado. Pulse Next.

4. Puede seleccionar el punto de montaje de la lista o introducirlo manual-
mente. Pulse Next.

5. Seleccione el formato de datos RTK del servidor RTK basado en la configu-
ración requerida de su proveedor de servicios RTK.
Seleccione el tipo de antena de referencia. Puede obtener esta información 
en el proveedor de red de corrección. La mayoría de redes o estaciones de 
referencia de corrección están configuradas para eliminar las compensa-
ciones de antena. En estos casos, puede seleccionar ADVNULLANTENNA.
Pulse Next.
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6. El cuadro de diálogo del estado de conexión aparecerá con todas las partes 
requeridas para la configuración verificadas.

• Pulse Finish después de haber realizado una prueba de conexión 
correcta.

• Pulsa Back para corregir cualquier error en su configuración.

 Se recomienda utilizar GG03/GG02 plus SmartAntenna para conseguir la 
mayor precisión posible de posición.

Paso Descripción
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3.3 Recogida de características con GNSS

Preparación de 
recogida de caracte-
rísticas con GNSS

Paso Descripción
1. Abra el GPS menú desplegable. Seleccione GPS Active.

Se conectará automáticamente a la antena que haya seleccionado en el GNSS 
cuadro de diálogo de ajustes.

2. El seguimiento del satélite se inicia ahora. Durante este proceso, aparecerá 
una ventana roja en la parte inferior de la página.

3. Si hay GPS una posición disponible, la ventana roja pasará a ser verde e indicará 
alguna información de posicionamiento. El GPS cursor también aparece en el 
mapa. 

 Si ha verificado los datos de registro para el post-proceso en GNSS  Settings, 
encontrará un símbolo en la barra GNSS de estado que le indicará la precisión 
estimada de post-proceso.
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Medición de un 
punto con GPS

Medición de una 
línea con GPS

Paso Descripción
1. Pulse el botón Start/Stop Editing en la barra de herramientas Edit.

La lista desplegable presenta todas las capas editables del mapa actual.

2. Seleccione una capa de puntos para su edición.
3. Pulse  en la barra de herramientas Edit para comenzar a capturar una carac-

terística de puntos.
4. Pulse  para grabar un punto medido por GNSS.
5. Introduzca los atributos de la nueva característica de puntos.

En el extremo superior del cuadro de diálogo encontrará el progreso de la GNSS 
medición.

6. Pulse OK. El punto se ha guardado en la capa.

 Utilice la barra de herramientas QuickCapture para recoger un punto con GNSS.

Paso Descripción
1. Pulse el botón Start/Stop Editing en la barra de herramientas Edit.

La lista desplegable presenta todas las capas editables del mapa actual.

2. Seleccione una capa de línea para su edición.
3. Pulse  en la barra de herramientas Edit para comenzar a capturar una carac-

terística de líneas.
4. Pulse  para grabar un vértice medido por GNSS.
5. Añada diferentes vértices para formar una característica de línea.
6. Pulse  para completar la captura.
7. Introduzca los atributos de la nueva característica de línea.
8. Pulse OK.

 Utilice la barra de herramientas QuickCapture para recoger un punto con GNSS.
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Medición de un polí-
gono con GPS

Paso Descripción
1. Pulse el botón Start/Stop Editing en la barra de herramientas Edit.

La lista desplegable presenta todas las capas editables del mapa actual.

2. Seleccione una capa de polígono para su edición.
3. Pulse  en la barra de herramientas Edit para comenzar con la captura de una 

característica de polígono.
4. Pulse  para grabar un vértice medido por GNSS.
5. Añada diferentes vértices para formar una característica de polígono.
6. Pulse  para completar la captura.
7. Introduzca los atributos de la nueva característica de línea.
8. Pulse OK.

 Utilice la barra de herramientas QuickCapture para recoger un punto con GNSS.
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3.4 Soporte de ArcGIS capas en línea

ArcGIS capas en 
línea

Zeno Field v2.0 o superiores permite la integración de ArcGIS capas en línea.
Las capas que pueden utilizarse como información de fondo en un Zeno Field proyecto 
son las siguientes:

• Bing Maps Roads
• Bing Maps Aerial
• Bing Maps Hybrid
• World Physical Map
• World Street Map
• World Topo Map

Paso Descripción
1. Seleccione Add Data from Server para añadir un ArcGIS mapa base en línea al 

nuevo mapa.
2. Seleccione uno de los servicios en línea ArcGIS disponibles, por ejemplo el 

servicio ArcGIS World Street Map.
3. Después de haber guardado la ArcGIS capa en línea, aparecerá dicha capa en 

Zeno Field.

 Una vez conectado con Internet, Zeno Field almacena los ArcGIS servicios en 
línea para el cuadro delimitador específico. Estas capas base almacenadas 
pueden utilizarse en el campo sin Internet durante 24 horas.

 Al utilizar ArcGIS mapas base en línea con datos existentes, asegúrese de 
añadir los datos existentes en el mapa ArcPad previamente. ArcPad reproyec-
tará los ArcGIS mapas base en línea al momento para encontrar su proyección 
existente de datos.
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3.5 Funcionamiento de la cámara

Funcionalidad del 
soporte de cámara 
en Zeno Field

Zeno Field admite la cámara interna de dispositivos móviles.

Pueden utilizarse las imágenes en Zeno Field de dos modos:

Tipo Descripción Preparación
Imagen indepen-
diente

Las imágenes no forman 
parte del atributo de una 
GIS capa.

No se requiere preparación.

La imagen como 
parte de un atri-
buto

Las imágenes se guardan 
como información adicional 
de una característica.
Ejemplo:
Tiene una capa con tres 
especies diferentes. Puede 
añadir una fotografía de 
cada árbol que será tratada 
como atributo.

Para guardar las imágenes como 
atributos en los datos, cree un 
campo de texto. Designe la foto-
grafía, imagen o dibujo del campo 
de texto. Asigne una longitud 
mínima de 20 caracteres. Este 
campo de texto se utiliza para 
guardar el enlace de la imagen en 
Zeno Field.
Puede crear un campo de texto en 
el asistente del proyecto en Zeno 
Office o directamente en Zeno 
Field al crear un nuevo shapefile.
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Configuración de 
ajustes de cámara 

Cómo hacer una 
fotografía indepen-
diente

Paso Descripción
1. Pulse .

2. Cambie a la pestaña Camera.
3. Seleccione la cámara en el menú desplegable de cámaras. La cámara interna 

viene fijada por defecto.

Para imágenes independientes Para imagen como parte de atributo
4. Fije la ruta de imágenes por defecto 

dónde se guardarán las fotografías.
• Las imágenes se guardan en la 

carpeta del proyecto. 
• El prefijo del nombre del archivo es 

el nombre del campo del atributo. 
• Ejemplo: La capa tiene el nombre 

calle y la fotografía está guardada 
en la imagen del campo de atributo. 
La fotografía lleva el nombre 
picture_00002.jpg.

5. Seleccione un prefijo del nombre del 
archivo.

6. Desplácese por la barra deslizante de calidad de imagen para cambiar la calidad 
de las fotografías. La calidad y tamaño de las imágenes aumenta de izquierda 
a derecha (opcional).

7. Verifique Date/time en el nombre del archivo para mostrar la fecha y hora en 
el nombre del archivo (opcional).

Paso Descripción
1. Inicie la barra de herramientas QuickCapture.
2. Pulse .

3. Pulse Capture para hacer la fotografía.
4. Guardar: Para guardar la imagen.

Discard: Para hacer una nueva fotografía.
5. Después de guardar la imagen, aparece un mensaje que indica la ruta de la 

fotografía.
6. Pulse OK.

 La posición GPS actual se añade automáticamente al encabezado EXIF del 
archivo *.jpg.
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Cómo hacer una 
fotografía como 
atributo

Paso Descripción
1. Cree una característica de punto, línea o polígono.
2. En la tabla de atributos de la característica:

Cambie a la pestaña Picture.

3. Pulse la lista desplegable Field.
Seleccione el atributo donde desea guardar la imagen.
El campo está preseleccionado en el atributo de campo con fotografía, imagen 
y dibujo.
La ruta de la fotografía está guardada en el campo seleccionado.

4. Pulse  en la parte inferior de la página. 
5. Pulse Capture para hacer la fotografía.
6. Guardar: Para guardar la imagen.

Discard: Para hacer una nueva fotografía.
7. Rote la imagen con .

8. Pulse OK para guardar la imagen como atributo.

 También puede navegar por la imagen como atributo desde el disco.

 La posición GPS actual se añade automáticamente al encabezado EXIF del 
archivo *.jpg.
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3.6 Funcionamiento de telémetro

La funcionalidad del 
telémetro se 
admite 
en Zeno Field

El telémetro se puede utilizar para mediciones de compensación:
• Distancia, orientación, inclinación
• Posición fija única
• Dos posiciones fijas

Los protocolos admitidos son los siguientes:
• Leica DISTO protocolo de interfaz 
• Leica Vector/Laser Locator formato de transferencia de datos 
• Laser Atlanta $LA1KA (original), $LA1KD (extended), $LA1KC (CMT, Corvallis 

MicroTechnology) 
• LaserCraft Contour $PLCI
• Laser Technology Criterion 400 format ($PLTIT)
• Dispositivos de medición Ltd. $PMDLA

Conexión con un 
dispositivo externo 
Bluetooth

Paso Descripción

 Las capturas de pantalla mostradas pertenecen a DISTO. Los menús pueden 
variar dependiendo de los dispositivos.

1. Inicie la aplicación Bluetooth en el Zeno 10/Zeno 15:
Pulse Start > Programs > Zeno Tools > Bluetooth Manager.

2.
Pulse  para buscar los dispositivos Bluetooth a su alcance.

 Asegúrese de que el Bluetooth esté encendido en el dispositivo y 
preparado para ser encontrado.

Después de la búsqueda, se encontraron nuevos dispositivos.

3. Pulse en el nuevo dispositivo para su uso. Seleccione Open en el menú 
contextual. Aparecen los servicios del dispositivo.

 Si se requiere la agrupación o no, depende del dispositivo. Consulte 
la guía de usuario del dispositivo Bluetooth para obtener información 
y la contraseña que se utilizará.

Si se requiere la agrupación:
4. Pulse Pair para agrupar el dispositivo.
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5. Pulse Serial Port Service > Connect en el menú contextual.

6. Seleccione el puerto COM que se asignará al dispositivo. En este caso: COM4

7. Pulse OK.
Se ha finalizado con la agrupación

8. Ahora el dispositivo y Zeno están conectados.

Pulse  para visualizar todas las conexiones a dispositivos incluida la infor-
mación detallada del puerto COM.

9.
Pulse  para cerrar el organizador Bluetooth.

10. Vaya a Zeno Field. Abra las preferencias del telémetro en Zeno Field.
11. Seleccione el protocolo correspondiente y el puerto COM al que se conectará 

el dispositivo. El nombre del dispositivo está escrito detrás del número de 
puerto COM.

12. Ahora puede trabajar con el dispositivo conectado.

Paso Descripción
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Conexión de un 
dispositivo 
Bluetooth externo a 
CS25

Paso Descripción
1. Asegúrese de que el Bluetooth esté encendido en el dispositivo y preparado 

para ser encontrado.
2. Abra el menú Bluetooth Devices haciendo clic  en la barra de tareas.
3. Seleccione Add a device.
4. Espere hasta que aparezca el telémetro en pantalla.
5. Seleccione el telémetro.

Seleccione Enter the device’s pairing code.
6. Introduzca el código de agrupación del telémetro. Consulte el manual de 

usuario del telémetro.
7. Pulse OK.

El dispositivo se conectará.
8. Vuelva a hacer clic   en la barra de tareas.
9. Abra el menú contextual del telémetro conectado y seleccione Properties.

10. Vaya a la pestaña Services.
Aparecerá el puerto serie Bluetooth al que está conectado en pantalla. 
Recuerde el puerto serie.

11. Ahora el dispositivo está correctamente agrupado con el CS25. Continúe con 
"Con el telémetro en Zeno Field".
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Conexión de un 
dispositivo 
Bluetooth externo a 
Zeno 5

Paso Descripción
1. Asegúrese de que el Bluetooth esté encendido en el dispositivo y preparado 

para ser encontrado.
2. Abra el organizador inalámbrico en Settings > Connections > Wireless 

Manager. Cambie a Bluetooth.
3. Abra el menú Bluetooth en Settings > Connections > Bluetooth  .
4. Pase a la pestaña Device.

Vaya a la pestaña Scan para buscar todos los dispositivos Bluetooth a 
su alcance.

5. Vaya a la pestaña del telémetro y seleccione Pair.
6. Introduzca el código de agrupación del telémetro. Consulte el manual de 

usuario del telémetro.
7. Pulse OK.

El dispositivo se conectará.
8. Verifique Serial Port para establecer un puerto serie.

9. Seleccione un puerto COM vacío del telémetro al que se conectará. 
Pulse OK.

10. Ahora el dispositivo está correctamente agrupado con el Zeno 5. Continúe 
con "Con el telémetro en Zeno Field".
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Con el telémetro en 
Zeno Field

En esta sección se explica cómo medir una compensación con orientación y distancia. 
Así su telémetro tendrá una brújula integrada.

Paso Descripción
1. Vaya a Zeno Field. Abra las preferencias del telémetro en Zeno Field.

2. Seleccione el protocolo correspondiente y el puerto COM al que se conectará 
el dispositivo. El nombre del dispositivo está escrito detrás del número de 
puerto COM.

3. Defina la tasa de baudios en caso necesario.
4. Verifique Automatically Activate.
5. Pulse OK.
6. Pulse Rangefinder Active.
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7. Seleccione una característica de punto para su edición.

8. Pulse Offset Point.

9. Realice una medición de orientación y distancia con el telémetro. Presione el 
disparador del telémetro. Aparecerá el cuadro de diálogo Point/Vertex.

10. Pase a la pestaña Offset y verifique los valores medidos.

11. Pulse  .
12. Pulse en el símbolo del satélite para medir el punto de referencia A por GPS.

13. Pulse OK dos veces.
14. Introduzca los atributos necesarios.

Pulse OK.

Paso Descripción
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3.7 Funcionamiento de la herramienta Digicat Cable Detection

Funcionamiento de 
Digicat

En esta sección podrá leer las instrucciones paso a paso para guardar los valores de 
profundidad medidos con una herramienta Cable Detection de Digicat (o Ezicat) 
enZeno Field.

 Es obligatorio contar con un localizador de cable Digicat con conectividad Blue-
tooth e indicar la profundidad del servicio.

Paso Descripción
1. Conecte el Zeno con su ordenador por cable.
2. Descargue e instale el software Digicat PPC en su PC. Podrá encontrarlo en 

myWorld. Siga la guía de uso del software Digicat PPC en su dispositivo móvil.
3. Inicie la herramienta de transferencia Digicat en Start > Programs > Digicat 

Transfer.
4. Ahora se abre la ventana de transferencia Digicat. No se ha detectado ningún 

Digicat.

5. Pulse y mantenga pulsado el disparador en el Digicat para activar el locali-
zador. Asegúrese de que la conectividad Bluetooth esté activada en el dispo-
sitivo. Lea el manual de Digicat para obtener más información.

6. La herramienta de transferencia Digicat detecta el dispositivo Digicat auto-
máticamente. No es necesario agrupar previamente.
En la ventana de transferencia Digicat encontrará información del dispositivo 
utilizado y un indicador discontinuo verde. Indica la respuesta del localizador 
a la señal. La información es idéntica al indicador de potencia de señal en el 
dispositivo Digicat.

7. Pulse y mantenga pulsado el botón i durante 2 s hasta que las líneas discon-
tinuas se hayan desplazado.

8. La lectura de la pantalla indica la profundidad del cable que se debe indicar.
9. Si hay que tomar una lectura de profundidad, el localizador mostrará LOG. 

Para transferir la información al registro de datos, pulse el botón i mientras 
LOG aparezca en pantalla.

10. El valor de profundidad aparecerá en pantalla en la ventana de transferencia.
11. Abra un proyecto en Zeno Field.
12. Genere una característica pulsando o midiendo hasta que aparezca un 

cuadro de diálogo de atributos.
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13. Pulse en el campo apropiado.
Mida la profundidad siguiente 7. a 9..
El valor se ha transferido a un campo de atributo en Zeno Field.

14. Guarde la característica.

 La herramienta de transferencia Digicat transmite el valor medido siempre a 
la posición del cursor. Esta opción también funcione en diferentes programas 
como Excel o Notepad.

Paso Descripción
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4 Transferencia de datos de retorno a Zeno Office con 
EasyIn

Requerimientos Para conseguir una transferencia correcta de datos de campo a Zeno Office, deben 
cumplirse los cuatro requisitos siguientes:

• Solamente es posible un Easylin con datos transferidos a Zeno Field por medio 
de un proceso EasyOut con Check Out (fijación).

• Los procesos EasyOut y EasyIN deberán realizarse desde el mismo proyecto de 
office.

• La barra de herramientas Survey Editor deberá estar encendida. Por eso, vaya a 
Customise > Customise Mode. Marque la casilla de selección situada al lado 
del editor.

• La opción Start Editing debe estar activa.

Importación de 
datos con EasyIn

Paso Descripción
1. Inicie Zeno Office.
2. Abra el proyecto en el que quiere incorporar los datos.
3. Haga clic en Editor > Start Editing.
4. Pulsar  en la Leica barra de herramientas Data Manager.

Si el botón no está disponible, vaya a Customise > Customise Mode y 
seleccione la barra de herramientas Leica Data Manager.

5. Si recibe este mensaje de error, vaya a Customise > Customise Mode y 
seleccione la barra de herramientas Leica Survey Editor.
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6. Explore la localización del proyecto. Puede navegar directamente por una 
conexión móvil o por la carpeta de intercambio de datos ActiveSync.

7. Seleccione todas las categorías de características que desee registrar.
8. Verifique Import Observations en caso de que quiera post-procesar ahora o 

más adelante.
9. Verifique Post Process Observations en caso de que quiera EasyIn post-

procesar sus observaciones en bruto.
10. Defina la localización de los datos de referencia:

• Local:
• Browse for Reference Data: Para explorar los datos de referencia
• Auto select Reference Data: Para seleccionar una carpeta que 

contenga sus datos de referencia. Defina la ruta de datos en los 
ajustes. Guarde los datos de referencia siempre en la misma 
carpeta. EasyIn automáticamente recogerá el archivo de referencia 
adecuado de esta carpeta.

• IGS Network: Para descargar automáticamente los datos de refe-
rencia.

11. Haga clic en OK.

Paso Descripción
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12. El visor EasyIn Live Data Viewer aparecerá e indicará todos los pasos reali-
zados automáticamente por EasyIn. Estos procesos son los siguientes:

1) Copia de seguridad del proyecto de campo para repetirlos EasyIn 
posteriormente en caso necesario.

2) Importación de fotografías enlazadas con las características recogidas 
en Zeno Field.

3) Registro de las características.
4) Creación de punto de muestreo de cada punto/vértice. Los puntos de 

muestreo incluyen por ejemplo, la calidad de información de cada 
punto/vértice.

5) Importación de mediciones de compensación.
6) Importación de observaciones móviles.
7) Importación de observaciones de estaciones base.
8) Post-proceso de observación con informe detallado del post-proceso.
9) Actualización de características a las posiciones de post-proceso y re-

computación de puntos de compensación.
10)Sincronización del proyecto entre la oficina y el proyecto de campo 

para evitar registros dobles.

 El rendimiento del proceso depende del proyecto y de los datos incluidos.

Paso Descripción



Zeno GIS, Trabajando con Zeno Office 71

5 Trabajando con Zeno Office
5.1 Opening a Map Document

Cómo abrir un docu-
mento de mapa

Un documento de mapa es un archivo *.mxd.
Para abrir un documento de mapa en Zeno Office, utilice uno de los métodos que 
aparecen en la lista.

Haga doble clic

Seleccione un mapa del Zeno Office cuadro de diálogo Getting Started

Cómo abrir otro mapa desde una Zeno Office sesión
Si ya está trabajando en Zeno Office, puede abrir otro documento de mapa. El mapa 
existente se cerrará y se abrirá el nuevo mapa.

Paso Descripción
1. En Windows Explorer, navegue hasta la localización del documento del mapa.
2. Haga doble clic en el archivo *.mxd.

Paso Descripción
1. Comience desde Zeno Office el menú Windows Start.

Aparecerá Zeno Office el cuadro de diálogo Getting Started.
2. Seleccione un mapa existente.
3. Haga clic en OK para abrir el mapa en Zeno Office.

Paso Descripción
1. Pulsar   o la barra de herramientas Standard.

o bien
Haga clic en File > Open.
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5.2 Adding a Dataset

Se añade un 
conjunto de datos

Los conjuntos de datos son términos genéricos para:
• Categoría de características
• Archivo de formas
• Archivo CAD (dxf, dgn, dwg)

Para añadir un conjunto de datos en Zeno Office, utilice uno de los métodos que 
aparecen en la lista.

Con un botón

Copiar o arrastrar

Paso Descripción
1. Pulsar .
2. Navegue hasta el conjunto de datos deseado.
3. Seleccione el conjunto de datos y haga clic en Add.

Paso Descripción

 Para desplazar conjuntos de datos entre las tramas de datos o mapas:
• Copie y pegue los conjuntos de datos
• Arrastre la capa desde una trama de datos a otra
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5.3 Barra de herramientas

Navegación por el 
mapa 

La barra de herramientas Tools incluye herramientas para trabajar con contenido 
dentro de la trama activa de datos, por ejemplo, para hacer panorámica o zoom , iden-
tificar características o medir distancias.

Icono Descripción
Acercar Para acercarse a una ventana geográfica haciendo clic en un 

punto o arrastrando un cuadro.

Alejar Para alejarse de una ventana geográfica haciendo clic en un 
punto o arrastrando un cuadro.

Panorámica Para hacer una panorámica de una trama de datos.

Alcance 
total

Para hacer zoom del alcance total de un mapa.

Acerca-
miento fijo

Para acercarse al centro de una trama de datos.

Aleja-
miento fijo

Para alejarse del centro de una trama de datos.

Atrás Para volver al alcance anterior.

Adelante Para ir al siguiente alcance.

Seleccionar 
caracterís-
ticas

Para seleccionar características gráficas haciendo clic o arras-
trando un cuadro a su alrededor.

Borrar 
selección

Para deseleccionar todas las características actuales seleccio-
nadas en la trama activa de datos.

Seleccionar 
elementos

Para seleccionar/cambiar tamaño/mover texto/gráficos/objetos 
situados en el mapa.

Identificar Para identificar una característica geográfica o un lugar en el 
mapa haciendo clic en el mismo.

Hiperenlace Para activar hiperenlaces de características.
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5.4 Índice

Funcionalidad En la tabla de contenido se visualiza:
• Una lista de todas las capas del mapa.
• Los símbolos de cada capa.

Vista de la tabla de contenidos por:
• Drawing Order
• Origen
• Visibilidad
• Selección

Utilice la tabla de contenidos para:
• Activar y desactivar capas
• Acceder a las propiedades de las capas
• Reorganizar capas para cambiar el orden del dibujo

Hacer clic derecho en una categoría de características para 
abrir el menú contextual.
Utilice el menú contextual para:

• Abrir la tabla de atributos como resumen de la infor-
mación de atributo

• Exportar la categoría de características a diferentes 
formatos

• Verificar y editar las propiedades de la categoría de 
características
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5.5 Data Frame Properties

Propiedades de la 
trama de datos

Una trama de datos
• es una ventana geográfica de visualización de GIS información.
• tiene propiedades que definen el contexto de visualización y trabaja con los 

datos incluidos.

Para visualizar y fijar las propiedades de una trama de datos

Paso Descripción
1. Haga doble clic en el nombre de la trama de datos en la tabla de contenido.
2. Haga clic en Properties.

3. Puede fijar y revisar varias propiedades en cada pestaña de este cuadro de 
diálogo. 
El sistema de coordenadas es una de las propiedades más importantes. El 
sistema de coordenadas define la proyección del mapa en la trama de datos. 
El sistema de coordenadas de su trama de datos viene determinado por el 
sistema de coordenadas del primer conjunto que añade a su mapa. Puede 
revisar y fijar el sistema de coordenadas de la trama de datos en la pestaña 
Coordinate Sistema del cuadro de diálogo Data Frame Properties.
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Paso Descripción
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5.6 Toolbox

ArcToolbox La ArcToolbox ventana el lugar central donde gestionará y ejecutará las herramientas 
de geoprocesos.
La ArcToolbox ventana incluye cajas de herramientas.
Las cajas de herramientas incluyen conjuntos de herramientas y herramientas indivi-
duales.
Un conjunto de herramienta es un dispositivo de organización similar a una carpeta de 
sistema.
Las herramientas deben formar parte de una caja de herramientas y no pueden existir 
fuera de la misma.
Ejemplos de herramientas: Importación/exportación de datos, conversión de catego-
rías de características, gestión de datos

Paso Descripción
1. Haga clic en Geoprocessing > ArcToolbox.
2. Aparecerá la caja de herramientas en una ventana separada.
3. Para encontrar la herramienta apropiada:

• Explore la herramienta en el ArcToolbox.
• Busque el nombre de la herramienta en Search Window (Windows > 

Search).
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5.7 Datos de Medición
5.7.1 Información general

Información general Base de datos
Zeno Office/Zeno Office en ArcGIS guarda dos conjuntos diferentes de datos en la 
base de datos:

Concepto de enlace
Los puntos de muestreo se guardan en el conjunto de datos Survey y están enlazados 
a las características. Survey Point y la característica están conectados directamente.

 EasyIn lleva las características medidas automáticamente a los puntos de 
muestreo enlazados.

Revisión, edición y búsqueda
La información de muestreo puede revisarse y editarse en el Zeno Office proyecto.
Dependiendo del proyecto específico, puede requerirse la información siguiente:

• Datos de puntos de muestreo, por ejemplo coordenadas e información de 
calidad

• GNSS observaciones con valores de calidad, altura de antena y satélites utili-
zados, por ejemplo.

• GNSS post-proceso: Tipo de solución y calidad

GeoDatabase

Categoría de características:
• Colección de características del mismo 

tipo y referencia espacial.
• Guarda la geometría y los atributos.
• Los tipos principales de categorías de 

características son punto, línea y polí-
gono.

Conjunto de datos de muestreo y 
proyecto de muestreo:
• Conjunto de datos de muestreo:

Contiene uno o más proyectos de 
muestreo con la misma referencia 
espacial.

• Proyectos de muestreo:
Guarda los datos de muestreo, por 
ejemplo puntos de muestreo, 
coordinadas, mediciones, compu-
taciones.

• Los puntos de muestreo pueden 
enlazarse a categorías de caracte-
rísticas basadas en muestreos.

Medición + Elemento = Linked Survey Feature
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5.7.2 Información de búsqueda

Funcionalidad Explore y edite los objetos de muestreo en el explorador Survey Explorer.
El explorador Survey Explorer es un contenedor de páginas de información de mues-
treo. Puede crear estas páginas mientras trabaja.
La información de muestreo puede visualizarse en pantalla de dos modos:

• Herramienta de lista de objetos de muestreo:
Crea una lista de objetos de muestro por búsqueda
Para seleccionar la información de muestro directamente desde el mapa

• Lista de objetos de muestreo por búsqueda:
Se visualiza la vista detallada de objetos de muestreo individuales

Herramienta de 
lista de objetos de 
muestreo:

Paso Descripción

 Los datos de muestreo pueden buscarse exclusivamente cuando se aplica 
un conjunto de datos de muestreo y dichos datos están dentro del 
proyecto.

1. Para activar la barra de herramientas Leica Survey Editor:
a) Seleccione Customise > Customise Mode.
b) Vaya a la pestaña Toolbars.
c) Verifique LeicaSurvey Editor.

2. Haga clic en el botón List Survey Objects Tool de la barra de herra-
mientas.

3. Haga clic y arrastre la caja alrededor de los puntos de muestreo y medidas 
de las que desea hacer una lista.

4. Se abre el explorador Survey Explorer y se añade una nueva página de 
listado. La página incluye mediciones y puntos que buscó en el mapa.

Consultar "Navegue hasta llegar a la información detallada de puntos de 
muestreo".
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Lista de objetos de 
muestreo por 
búsqueda

Paso Descripción

 Los datos de muestreo pueden buscarse exclusivamente cuando se aplica 
un conjunto de datos de muestreo y dichos datos están dentro del 
proyecto.

1. Para activar la barra de herramientas Leica Survey Editor:
a) Seleccione Customise > Customise Mode.
b) Vaya a la pestaña Toolbars.
c) Verifique LeicaSurvey Editor.

2. Verifique List Survey Objects con el botón Query en la barra de herra-
mientas.

3. Aparecerá el cuadro de diálogo The List Survey Objects by Query.

4. Verifique el tipo de objetos que desee buscar.
5. Para realizar varias búsquedas, pulse Query Builder.
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6. Defina la búsqueda en base a sus necesidades.

7. Haga doble clic en OK.
8. Aparecerá la información correspondiente a su entrada de búsqueda.

Paso Descripción
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Navegue hasta 
llegar a la informa-
ción detallada de 
puntos de muestreo

En esta sección se explica cómo navegar por la página detallada de puntos de mues-
treo dentro del Survey Explorer. Puede introducir la información de muestreo en la 
herramienta List Survey objects o por búsqueda.

Paso Descripción
1. Asegúrese de haber creado una página de lista con los puntos de muestreo 

desde una selección o búsqueda.

2. Haga clic derecho en la columna principal para seleccionar la línea deseada de 
un punto de muestreo.

3. Seleccione Go to Details.

 Para introducir la GNSS medición de un punto de muestreo, seleccione Go to 
Measurement.

 Para borrar un punto de muestreo, seleccione la línea correspondiente y haga 
clic en la cruz roja.

 Para crear un informe basado en texto de los datos seleccionados de mues-
treo, marque la/s línea/s y seleccione Survey Object Report...

 Navegue hasta la página siguiente o anterior con el botón de flecha derecha e 
izquierda.

4. La ventana Details aparecerá con los puntos seleccionados de muestreo. La 
ventana incluye tres pestañas:

• Pestaña general:
Presenta el nombre editable del punto de muestreo y la GIS coordenada. 
La GIS coordenada define la localización del punto de muestreo en el 
mapa.

• Pestaña de calidad:
Presenta los parámetros de calidad, por ejemplo la desviación típica.

• Coordinate Manager:
Presenta las coordenadas almacenadas con el punto de muestreo. Las 
coordenadas pueden modificarse manualmente. Un punto de muestreo 
puede tener más de una coordenada en diferentes computaciones.



Zeno GIS, Trabajando con Zeno Office 83

Navegue hasta 
GNSS la informa-
ción detallada de 
información

En esta sección se explica cómo navegar hasta la página de información detallada de 
GNSS observaciones dentro del Survey Explorer. Puede introducir la información de 
muestreo en la herramienta List Survey objects o por búsqueda.

Paso Descripción

Paso Descripción
1. Asegúrese de haber creado una página de lista con las GNSS observaciones de 

una selección o búsqueda.

2. Haga clic derecho en la columna principal para seleccionar la línea deseada de 
una GNSS observación.

3. Seleccione Go to Details.
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 Para introducir un punto de muestreo referido a una GNSS observación, selec-
cione Go to Survey Points.

 Para borrar una GNSS observación, seleccione la línea correspondiente y haga 
clic en la cruz roja.

 Para crear un informe basado en texto de los datos seleccionados de mues-
treo, marque la/s línea/s y seleccione Survey Object Report...

 Navegue hasta la página siguiente o anterior con el botón de flecha derecha e 
izquierda.

4. Aparecerá la ventana Details de la observación GNSS seleccionada.
Puede cambiar

• Altura de antena
• Tipo de antena

Paso Descripción
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5.7.3 Computación de post-proceso

Post-proceso En esta sección se explica cómo navegar hasta la computación de post-proceso con 
Survey Explorer.
Para seguir esta directriz, se recomienda previamente EasyIn asegurarse de que hay 
una computación disponible.

Paso Descripción
1. Verifique List Survey Objects con el botón Query en la barra de herra-

mientas.

2. Verifique GNSS Post-Processing y haga clic en OK.
3. Seleccione la computación apropiada haciendo clic en la columna principal.
4. Haga clic derecho en la columna principal y seleccione Go to Details.

5. La ventana Details de post-proceso incluye varias pestañas.

• Pestaña general:
Son editables: Ángulo de corte, tipo de solución, GNSS tipo

• Pestaña de línea base:
Define las líneas base
Compruebe la referencia utilizada para cada móvil.

• Pestaña de puntos:
Revise las propiedades de todos los puntos de computación, por ejemplo 
GNSS tipo, coordinadas, calidad de posición/altura.
Revise las propiedades de los puntos no procesados, por ejemplo la 
estación base, GNSS tipo, tipo de solución, valores DOP
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• Pestaña de observación:
Ventana de estación base (ventana superior): Fije un filtro para visualizar 
sus GNSS mediciones en la pestaña de observación, importe manual-
mente los datos de referencia para el post-proceso. También puede 
realizar el post-proceso automáticamente durante Easyln.
Ventana de móvil (ventana inferior): Borre las observaciones, recupere 
todas las observaciones borradas, deshabilite (todas) las observaciones, 
importe datos móviles, fije un filtro para visualizar sus GNSS mediciones 
en la pestaña Observation

 Después de editar los valores en una GNSS computación de post-proceso, por 
ejemplo el ángulo de corte o el GNSS tipo, deberá re-computerizar.
Para re-computerizar, pulse Compute en Survey Explorer.

El estado de computación se indica en la parte inferior de la página:

•  No se requiere re-computación

•  Se requiere re-computación

Paso Descripción
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5.7.4 Cálculos geométricos

COGO En esta sección podrá ver un resumen de las construcciones COGO.
El ejemplo de flujo de trabajo de la tabla explica cómo construir las huellas en un 
bordillo de carretera.
Puede utilizar la información del mapa de cuatro modos diferentes para las construc-
ciones COGO en Zeno Office. El flujo de trabajo cubre los cuatro métodos de entrada.

Paso Descripción
1. Inicie Zeno Office y abra un proyecto.
2. Cree una categoría de características de polígono denominada 

Land_Parcel.
3. Acerca la zona donde quiera trabajar.
4. La primera computación es la construcción dirección-distancia.

Pulse el icono Dir-Dist en la barra de herramientas Survey Editor.

5. La ventana Survey Explorer se abre en la página Dir-Dist.

6. a) Haga clic en el campo From Point.
b) Haga clic en un punto de muestro del mapa.

P1.BP1000 deberá aparecer en pantalla en el campo From Point.
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7. El campo Direction está resaltado.
La entrada Direction está activa.
Aparece una línea en pantalla.

8. Seleccione un segmento de característica en el mapa para conseguir la 
dirección. La opción Snapping debe estar fijada a un vértice.

• Para Zeno Office v3.0 y versiones superiores:
Verifique en Editor > Snapping > Snapping Toolbar.

• Para Zeno Office versiones inferiores a v3.0:
Vaya a Editor > Snapping. Verifique la casilla Land_Parcel. Cierre 
el cuadro de diálogo Snapping Environment. Puede ir a Snapping 
Environment mientras esté activa la computación, no afectará a la 
computación.

9. Ajuste la casilla Land_Parcel. Consulte la imagen.

 La dirección pueden variar unos 200 gon, dependiendo de la posi-
ción del cursor. La línea central del segmento lo divide en dos 
direcciones.

10. a) Haga clic izquierdo para añadir la dirección a Survey Explorer.
b) Verifique que la dirección apunta a la derecha.

11. El campo Distance está resaltado.
Aparece un círculo. Arrastre el radio del círculo para definir la distancia.

o bien
Introduzca 10 en el campo Distance.

12. a) Introduzca un nombre en el campo de punto Result, por ejemplo, P1.RE1.

Paso Descripción
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b) Pulse Enter.
El punto computerizado aparecerá en el mapa.

13. Seleccione Editor > Save Edits para guardar las entradas.
14.

Pulse  en Survey Explorer para computerizar cualquier punto de la 
huella en el bordillo de la carretera.

15. Aparecerá una página vacía Dir-Dist en Survey Explorer.
16. Pulse Enter para confirmar el punto sugerido RE en el campo From Point.
17. El campo Direction está resaltado.

Queremos ajustar esta dirección al bordillo de característica de parcela. 
Quiere que la carretera construida esté en pararelo al segmento 
Land_Parcel, que comienza en BP1000 y se dirige al sudeste.

18. a) Ajústelo al segmento Land_Parcel.
b) Haga clic izquierdo para añadir la dirección a Survey Explorer.
c) Verifique que la dirección apunta a la derecha.

19. El campo Distance está resaltado.
Introduzca 100 en el campo Distance.

Paso Descripción
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20. Se sugiere P1.RE2 en el campo Result Point.
Pulse Enter.

21. Ahora queremos trabajar con una computación de intersección:
Pulse el icono Dist-Dist_Inter.

22. Aparecerá una página vacía Dist-Dist-Inter en Survey Explorer.
23. Seleccione First Point, por ejemplo P1.RE2 ajustando el punto.
24. a) El campo Distance está resaltado.
25. b) Introduzca 14.142 m.

c) Pulse Enter.
26. El campo Second Point está resaltado.

Ajuste al punto P1.RE3.
27. El campo Second Distance está resaltado.

Consiga la distancia deseada desplazando el cursor desde P1.RE3 y ajús-
telo a P1.RE2.

28. Haga clic izquierdo para añadir el valor al campo Second Distance.
29. El menú desplegable Solution está resaltado.

La selección correcta es Accept Right.
30. Se sugiere la opción Result Point.

Pulse Enter para aceptar el nombre de punto sugerido.
31. El campo Second Point está resaltado.

Ajuste al punto P1.RE3.

Paso Descripción
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6 Feature Service Sync en Zeno Field

Descripción Uso
Para sincronizar las ediciones realizadas en Zeno Field en el aire con ArcGIS en línea y 
Zeno Office.

Requerimientos
• Para Zeno Field v3.2 o versiones superiores en CS25/Zeno 5
• Zeno Office en ArcGIS v3.2, ArcGIS v10.1 o v10.2
• ArcGIS Suscripción en línea
• Active la conexión a Internet establecida por:

• Ejecutar una corrección RTK
o bien
• Para Zeno 5: Iniciar Internet Explorer
o bien
• Para CS25: Conectarse a Internet en One Click Internet o AirCard Watcher

Restricciones
• ArcGIS En línea, es obligatorio que este servicio admita exclusivamente WGS84. No 

se admiten archivos geoides ni CSCS.
• Funciona exclusivamente en categorías de características. No se admiten puntos de 

muestreo ni observaciones.

Using Sync Paso Descripción
Proceso Sync en Zeno Office
1. Se inicia Zeno Office en ArcGIS. Inicie sesión en ArcGIS en línea.

2. Cree un proyecto en Zeno Office en ArcGIS en WGS84 o utilice una base de 
datos existente en WGS84.
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3. Elimine las capas de conjuntos de datos de muestro y MobileMatriX las capas 
de inserción de línea del proyecto. El servicio de características solamente 
funciona con categorías de características.

4. Seleccione File > Share As > Service.
5. Seleccione Publish as a service.

Pulse Next.

6. Seleccione su ArcGIS conexión en línea e introduzca un nombre de servicio.
Pulse Continue.

7. Service Editor
Pulse Capabilities en el siguiente Service Editor. Verifique Feature Access.
Uncheck Tiled Mapping.
Verifique Feature Access.

Paso Descripción
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8. Pulse Feature Access. Seleccione todas las actividades.
9. Pulse Item Description. Debe introducir una descripción.

10. Pulse Sharing. Comparta el servicio de características con su cuenta

11. Pulse Analyse para verificar su proyecto.
Los errores, avisos y mensajes aparecen en la parte inferior de la página. 
Deberá solucionar los errores marcados con una cruz roja para continuar con 
la característica de sincronización.

12. Pulse Publish para ofrecer el servicio ArcGIS Online.

Paso Descripción
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13. El servicio ofrecido está disponible en su ArcGIS portal en línea en la sección 
My Content.

Proceso de sincronización en Zeno Field
14. Abra un nuevo mapa en Zeno Field.
15. Abra las Zeno Field  opciones. En la pestaña Server, introduzca sus ArcGIS 

credenciales en línea.
Pulse OK.

16. Seleccione File> ArcPad Packages > Download Zeno Field project.

17. Conéctese a http://www.argis.com. Seleccione su servicio de característica.

18. El proyecto está descargando de ArcGIS en línea.
19. Inicie el trabajo de muestreo.
20. Sincronice sus ediciones de vez en cuando con ArcGIS Online

Abra el menú desplegable Open the Add Layer. Seleccione Synchronise 
Data with ArcGIS Server. Los datos están sincronizados con ArcGIS en línea.

Paso Descripción
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El proceso de sincronización entre Zeno Office y ArcGIS en línea
21. Abra un mapa vació en Zeno Office.
22. Vuelva a cargar el proyecto de oficina generado previamente que se utilizó 

para la sincronización de características directamente desde ArcGIS en línea. 
De lo contrario fallará el proceso de sincronización.
Seleccione File> ArcGISOnline

23. Seleccione MyMaps and Data.
Añada su proyecto en la siguiente ventana.

24. Ahora todas las ediciones medidas en el campo están disponibles en el Zeno 
Office proyecto.

Paso Descripción
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Zeno Office

Zeno Field

 • En el momento en que se realizó una edición en Zeno Field y se subió a 
ArcGIS en línea, Zeno Office se sincronizará después de la actualización 
del mapa. Una edición es una nueva característica, una característica 
editada o eliminada.

• Las ediciones realizadas en Zeno Office también afectan al contenido del 
proyecto utilizado en Zeno Field , dependiendo de los ajustes de Feature 
Access.

• Los servicios de una característica en ArcGIS en línea se pueden sincro-
nizar en múltiples dispositivos, por ejemplo GIS portátiles, escritorio GIS.

Paso Descripción
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7 Zeno Tools
7.1 Introducción

Funcionalidad de 
Zeno Tools

Zeno Tools incluye las aplicaciones para configurar: 
• Zeno 5
• Zeno 10/Zeno 15
• CS25
• CS25 GNSS
• GG02 plus
• GG03

Dependiendo del hardware en que Zeno Tools se ha instalado, es posible utilizar las 
siguientes aplicaciones:

Instalación en
Zeno 5 • Licence Manager
Zeno 10/Zeno 15 • Bluetooth Manager para conectar dispositivos externos 

Bluetooth como el telémetro láser
• Cambie los ajustes del sistema

Ejemplo: Tamaño de fuente
• Añada nuevas claves de licencia

Ejemplo: Nueva clave de mantenimiento o clave Glonass 
para el GS05/GS06

• Cómo subir un nuevo firmware para las GS05/GS06 mayús-
culas

CS25 • Subida de un nuevo firmware en un GG03/GG02 plus
• Subida de claves de actualización en un GG03/GG02 plus o 

CS25 GNSS
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7.2 Zeno Tools en Zeno 10/Zeno 15
7.2.1 Using the System Settings Manager

Funcionalidad En System Settings Manager puede:
• Cambiar los tamaños de fuente
• Reiniciar la selección GS05/GS06 a los ajustes por defecto de fábrica. El reinicio 

borra el almanaque y reinicia la selección.
• Definir la velocidad USB

Cambiar el tamaño 
de fuente del 
sistema

Utilice esta herramienta para fijar el tamaño de fuente del sistema en el Zeno dispo-
sitivo portátil. Los tamaños de fuente disponibles son pequeño, mediano, grande y 
Zeno fuentes optimizadas.

 Si utiliza tamaños de fuente más grandes, los cuadros de diálogo también 
cambiarán de tamaño. Algunos cuadros de diálogo ya no serán totalmente visi-
bles.

Cambio de ajustes 
USB

Es posible modificar la velocidad USB de USB Full Speed al ajuste más rápido USB High 
Speed. Este ajuste es obligatorio ya que algunos ordenadores no admiten USB High 
Speed.

Reinicio de 
GS05/GS06 GNSS 
selección

La función de reinicio de GS05/GS06 reinicia los ajustes por defecto de fábrica. Es 
decir, por ejemplo se borra el almanaque. Un reinicio puede ser útil para adquirir una 
posición con mayor rapidez después de que Zeno el dispositivo se haya desplazado a 
una distancia larga. 

Paso Descripción
1. Inicie System Settings Manager en su Zeno 10/Zeno 10:

Pulse Start > Programs > Zeno Tools > System Settings Manager.
2. Seleccione el tamaño de texto preferido.
3. Pulse OK. En un cuadro de diálogo se le indicará que debe reiniciar el sistema. 

Pulse Yes para reiniciar el sistema con los nuevos ajustes de tamaño de texto.

Paso Descripción
1. Inicie System Settings Manager en el Zeno 10/Zeno 15:

Pulse Start > Programs > Zeno Tools > System Settings Manager.
2. Pase a la pestaña USB Settings.
3. Seleccione la velocidad USB preferida.
4. Pulse OK. En un cuadro de diálogo se le indicará que debe reiniciar el sistema. 

Pulse Yes para reiniciar el sistema con los nuevos ajustes de velocidad USB.

Paso Descripción
1. Inicie System Settings Manager en su Zeno 10/Zeno 15:

Pulse Start > Programs > Zeno Tools > System Settings Manager.
2. Pase a la pestaña Reset.
3. Pulse Reset.
4. Pulse OK para cerrar System Settings Manager.
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7.2.2 Con el GS05/GS06 Firmware Loader

Funcionalidad Utilice Firmware Loader para subir un nuevo firmware al GS05/GS06.

 Asegúrese siempre de tener suficiente potencia de batería durante la subida 
del firmware.

 Para subir un nuevo firmware, necesitaría una clave CCP válida. Antes de la 
navegación y la subida, deberá copiar el nuevo firmware en el Zeno.

Carga de firmware

7.2.3 Using the Licence Manager

Licencias Consultar "1 Instalación y licencia de Zeno Field y Zeno Connect".

Paso Descripción
1. Descargue el archivo de firmware GS05/GS06 más reciente de 

https://myworld.leica-geosystems.com.
2. Copie el GS05/GS06 archivo de firmware en una carpeta en la Zeno 10/Zeno 

15, tarjeta SD, Leica tarjeta flash compacta o llave USB por ActiveSync o 
centro de dispositivos móviles, tarjeta de memoria USB o tarjeta SD.

3. Inicie GS05/GS06 Firmware Loader en el Zeno 10/Zeno 15:
Pulse Start > Programs > Zeno Tools > GS05/GS06 Firmware Loader.

4. Pulse en el icono de la carpeta en el cuadro de diálogo para cargar el 
firmware.

5. Navegue hasta llegar el directorio del GS05/GS06 archivo del firmware.
6. Seleccione el GS05/GS06 archivo del firmware e inicie la subida.
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7.2.4 Using the Bluetooth App

Funcionalidad La aplicación Bluetooth se utiliza para configurar las conexiones Bluetooth a disposi-
tivos Bluetooth externos. Puede tratarse de un telémetro láser, que se puede utilizar 
en Zeno Field o en un PC al que se deberá transmitir NMEA de forma inalámbrica.
Bluetooth Manager configura la conexión Bluetooth y todos los puertos y servicios 
requeridos. La conexión actual Bluetooth se establece automáticamente en cuanto 
una aplicación como Zeno Field abre el puerto COM correspondiente. 

Interfaz de usuario 
Bluetooth

Icono Descripción
Muestra los dispositivos Bluetooth al alcance.

Busca dispositivos Bluetooth al alcance.

Detiene la búsqueda de dispositivos Bluetooth al alcance.

Dispositivos registrados
Presenta dispositivos conectados en el pasado.

Servicios locales
Ofrece servicios a dispositivos remotos, por ejemplo un puerto serie 
para su transferencia de NMEA a un PC.

Propiedades
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Conexión con un 
dispositivo externo 
Bluetooth

Paso Descripción

 Las capturas de pantalla mostradas pertenecen a DISTO. Los menús pueden 
variar dependiendo de los dispositivos.

1. Inicie la aplicación Bluetooth en el Zeno 10/Zeno 15:
Pulse Start > Programs > Zeno Tools > Bluetooth Manager.

2.
Pulse  para buscar los dispositivos Bluetooth a su alcance.

 Asegúrese de que el Bluetooth esté encendido en el dispositivo y 
preparado para ser encontrado.

Después de la búsqueda, se encontraron nuevos dispositivos.

3. Pulse en el nuevo dispositivo para su uso. Seleccione Open en el menú 
contextual. Aparecen los servicios del dispositivo.

 Si se requiere la agrupación o no, depende del dispositivo. Consulte 
la guía de usuario del dispositivo Bluetooth para obtener información 
y la contraseña que se utilizará.

Si se requiere la agrupación:
4. Pulse Pair para agrupar el dispositivo.
5. Pulse Serial Port Service > Connect en el menú contextual.

6. Seleccione el puerto COM que se asignará al dispositivo. En este caso: COM4

7. Pulse OK.
Se ha finalizado con la agrupación

8. Ahora el dispositivo y Zeno están conectados.

Pulse  para visualizar todas las conexiones a dispositivos incluida la infor-
mación detallada del puerto COM.
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Con un Leica DISTO 
por Bluetooth

Un Leica DISTO con Bluetooth activado se puede conectar a Zeno con el Leica DISTO 
software Transfer PPC. Puede descargar Leica DISTO Transfer PPC desde 
myWorld@Leica Geosystems (https://myworld.leica-geosystems.com).
El software DISTOTransfer PPC se puede utilizar para transferir valores a Zeno Field o 
a cualquier otra aplicación. 

Instalación del Leica DISTO software Transfer PPC en el Zeno

9.
Pulse  para cerrar el organizador Bluetooth.

10. Vaya a Zeno Field. Abra las preferencias del telémetro en Zeno Field.
11. Seleccione el protocolo correspondiente y el puerto COM al que se conectará 

el dispositivo. El nombre del dispositivo está escrito detrás del número de 
puerto COM.

12. Ahora puede trabajar con el dispositivo conectado.

Paso Descripción

Paso Descripción
1. Descargue el Leica DISTO software Transfer PPC desde 

https://myworld.leica-geosystems.com.
Copie SetupDistoPPC.exe en el PC.

2. Conecte el Zeno al PC con ActiveSync o el centro de dispositivos móviles de 
Windows.

3. Ejecute SetupDistoPPC.exe en el PC.
4. Seleccione el idioma y haga clic en OK. Se inicia el asistente DISTO 

Transfer PPC Setup Wizard.
5. Haga clic para aceptar el acuerdo de licencia. Se inicia la instalación.
6. Haga clic en Yes para instalar DISTO Transfer PPC en la ruta de aplicación 

estándar en el Zeno.
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Conectar un DISTO por primera vez a DISTO Transfer PPC

Using DISTO Transfer PPC para transferir valores a Zeno Field

Paso Descripción
1. Encienda el DISTO Asegúrese de que el Bluetooth esté activado.

 Al pulsar la tecla Bluetooth, se encenderá y apagará el Bluetooth.
2. Inicie DISTO Transfer PPC en el Zeno:

Pulse Start > Programs > DISTO Transfer.
3. Seleccione el idioma deseado y pulse OK.
4. Aparecerá un cuadro de diálogo con todos los activoDISTOs al alcance.

Seleccione su DISTO y pulse OK.

 La próxima vez, DISTO Transfer PPC se conectará a su DISTO automática-
mente.

Paso Descripción
1. Encienda el DISTO Asegúrese de que el Bluetooth esté activado.

 Al pulsar la tecla Bluetooth, se encenderá y apagará el Bluetooth.
2. Inicie DISTO Transfer PPC en el Zeno:

Pulse Start > Programs > DISTO Transfer.
3. DISTO Transfer PPC se inicia y se conecta a su DISTO automáticamente.
4. Se recomienda utilizar los siguientes ajustes:

5. Haga clic en el campo en el que se debe introducir la DISTO medición.

 Puede enviar un valor medido a cualquier campo editable de cualquier 
aplicación. En Zeno Field puede tratarse del campo de distancia en el 
cuadro de diálogo de punto de compensación o un campo de atri-
buto, por ejemplo la profundidad de pozo.

6. Realice la medición de distancia con el DISTO.
7. Pulse la tecla Bluetooth en el DISTO para transferir el valor del campo de 

edición seleccionado.
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7.3 Zeno Tools en CS25

Subida de firmware 
para 
GG03/GG02 plus

Con Zeno Tools instalado en el CS25, puede subir un nuevo firmware al GG03/GG02 
plus.

Subida de firmware 
para 
CS25 GNSS

Con Zeno Tools instalado en el CS25 podrá subir el nuevo firmware al CS25 GNSS.

Paso Descripción
1. Conecte GG03/GG02 plus a su PC por Bluetooth o GEV162 cable.
2. Inicie la herramienta Firmware Loader en su CS25 pulsando Start > All 

Programs > Leica Geosystems > Leica Zeno Tools > Firmware Loader 
GG0X.

3. Cambie a GG03/GG02 plus.
4. Haga clic en la flecha desplegable del puerto COM para seleccionar el puerto 

serie en CS25 al que se conectará con el GG03/GG02 plus. El número de 
puerto COM Bluetooth se encuentra en la pestaña Hardware de Bluetooth 
Device Properties.

5. Navegue por el nuevo firmware. 
6. Compruebe que el número de versión del nuevo firmware es superior al de la 

versión actual.
7. Haga clic en Upload para iniciar la actualización de firmware.
8. Haga clic en Close al finalizar con la subida.

Paso Descripción
1. Inicie la herramienta Firmware Loader en su CS25 pulsando Start > All 

Programs > Leica Geosystems > Leica Zeno Tools > Firmware Loader 
GG0X.

2. Haga clic en la flecha desplegable del puerto COM para seleccionar el puerto 
COM con la descripción CS25 GNSS  del dispositivo.

3. Navegue por el nuevo firmware.
4. Compruebe que el número de versión del nuevo firmware es superior al de la 

versión actual.
5. Las opciones de subida adicional a un GG03/CS25 GNSS es posible con la 

herramienta GNSS Upgrade Key.
Haga clic en Upload para iniciar la actualización de firmware.

6. Haga clic en Close al finalizar con la subida.



Zeno GIS, Zeno Tools 105

Subiendo GNSS 
claves de 
actualización en 
GG03

Con Zeno Tools instalado en el CS25, podrá subir un nuevo firmware al GG03.

Subiendo GNSS 
claves de actualiza-
ción en 
CS25 GNSS

Con Zeno Tools instalado en el CS25 podrá subir el nuevo firmware al CS25 GNSS.

7.4 Zeno Tools en Zeno 5

Funcionalidad Con Zeno Tools instalado en un Zeno 5, puede obtener la licencia de su software en 
Licence Manager.

Paso Descripción
1. Conecte GG03 a su PC por Bluetooth o GEV162 cable.
2. Inicie la Leica Zeno GNSS herramienta Upgrade Key en su CS25 pulsando 

Start > All Programs > Leica Geosystems > Leica Zeno Tools > 
GNSS Upgrade Key.

3. Cambie en el GG03.
4. Haga clic en la flecha desplegable del puerto COM para seleccionar el puerto 

serie en el CS25conectado con el GG03.   El número de puerto COM Bluetooth 
se encuentra en la pestaña Hardware de Bluetooth Device Properties.

5. Introduzca el código de autorización. Este código viene impreso en su factura 
y también puede descargarlo desde la información detallada del dispositivo 
en myWorld@Leica Geosystems (https://myworld.leica-geosys-
tems.com).

6. Haga clic en OK.

Paso Descripción
1. Inicie la Leica Zeno GNSS herramienta Upgrade Key en su CS25 GNSS 

pulsando Start > All Programs > Leica Geosystems > Leica Zeno Tools > 
GNSS Upgrade Key.

2. Haga clic en la flecha desplegable del puerto COM para seleccionar el puerto 
COM con la descripción CS25 GNSS  del dispositivo.

3. Introduzca el código de autorización. Este código viene impreso en su factura 
y también puede descargarlo en la información detallada del dispositivo 
desde myWorld@Leica Geosystems (https://myworld.leica-geosys-
tems.com).

4. Haga clic en OK.
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